
hyperMILL®

Release notes 2024 | Update 1



This document is intended for users and administrators. It applies to hyperMILL®, hyperMILL® SHOP Viewer, hyperMILL®CAD, CAD
Viewer, hyperMILL® for SOLIDWORKS, and hyperMILL® for Autodesk® Inventor®.

The document is installed in the directory ...\OPEN MIND\doc\[Version number]\Readme... .

Useful information about hardware and software requirements, graphic cards for hyperMILL®CAD, installation requirements as well as
an installation guide can be found on our website at: Useful information

If you work with third-party software that uses hyperMILL® data (such as postprocessors and simulation tools), you should consider the
following: The format of all data generated by hyperMILL® can be changed by OPEN MIND without prior notice and at any time for the
purposes of further development. This primarily affects the output of machine- and control-neutral programs (POF format). OPEN MIND
does not offer any guarantee for problems that are due to compatibility issues involving third-party software.

OPEN MIND Technologies AG

Argelsrieder Feld 5
82234 Wessling
Germany
Tel.: (+49-8153) 933-500
Fax: (+49-8153) 933-501
E-mail: <sales.europe@openmind-tech.com>
Web: www.openmind-tech.com

Compliance Intelligence
The Software may include a compliance intelligence mechanism for security and reporting purposes ("Security Mechanism") that
automatically collects and transmits data regarding the installation and use of the Software to OPEN MIND Technologies AG, its
licensor and the manufacturer of the Security Mechanism for purposes of verifying End Customer's compliance with the terms of the
applicable EULA, identifying unauthorized use and users, and otherwise protecting and enforcing intellectual property rights. Data
processed through the security mechanism may include, but is not limited to, user, device and network identification information,
location and organizational domain information and software usage information. For more information about the processing of personal
data through the Security Mechanism, please see our privacy policy at https://www.openmind-tech.com/en/privacy/ .

(produced on Mon, Jun 10, 2024)

https://www.openmind-tech.com/de/service/support/nuetzliche-informationen.html
https://www.openmind-tech.com/en/privacy/


Table of Contents
1. Supported Versions ......................................................................................................................  2

Operating systems und CAD platforms ........................................................................................  2
CAD interfaces .......................................................................................................................  2
Interfaces Tool database ...........................................................................................................  5
Supported EDM formats ...........................................................................................................  5
Supported OPTICAM Software Versions ......................................................................................  6
Interfaces NC simulations .........................................................................................................  6

2. New commands and additions ........................................................................................................  7
CAM .....................................................................................................................................  7

User interface .................................................................................................................  7
hyperMILL and CAD program ....................................................................................  7
The hyperMILL browser ............................................................................................  7

Basics of CAM editing ......................................................................................................  7
Specifying the basic settings ......................................................................................  8
NC system and frames .............................................................................................  8
Tool management ...................................................................................................  8
Structure CAM project ..............................................................................................  9
Simulate machining ...............................................................................................  12
hyperMILL additional functions .................................................................................  14

Turning .......................................................................................................................  15
Roughing .............................................................................................................  15
Grooving .............................................................................................................  16

Drilling ........................................................................................................................  17
Optimized deep Hole Drilling (new) ...........................................................................  17

2D Machining ...............................................................................................................  21
Contour Milling on 3D Model ....................................................................................  21
Chamfer Milling on 3D Model ...................................................................................  22

3D Machining ...............................................................................................................  22
Profile Finishing ....................................................................................................  22
Z Level Shape Finishing .........................................................................................  25
Plane Machining ...................................................................................................  25
Cutting edge .........................................................................................................  26

5X Machining ...............................................................................................................  27
Cavity Milling ........................................................................................................  27
Additive Manufacturing ...........................................................................................  31
Tube Milling .........................................................................................................  32
Multiblade Milling ...................................................................................................  33

Tool database ...............................................................................................................  33
Define turning tool .................................................................................................  33
Create indexable cutter ...........................................................................................  33
Optimal barrel cutter ..............................................................................................  35
Tool series and technology templates ........................................................................  37
Define coupling .....................................................................................................  58

VIRTUAL Machining Center .....................................................................................................  58
Program run (simulation) .................................................................................................  58

Controlling visibility in the graphics area .....................................................................  58
Simulating the VNC or NC program file ......................................................................  59
Collision check and material removal .........................................................................  60

Configuration ................................................................................................................  60
TOOL Builder .......................................................................................................................  60

Introduction ..................................................................................................................  60
Steps for creating ..........................................................................................................  61

Turning tool: Creating a static holder for machining with a turret ......................................  61
CAD ...................................................................................................................................  63

Introduction ..................................................................................................................  63
Documentation and help .........................................................................................  63

User interface ...............................................................................................................  64
Tabs ...................................................................................................................  64

hyperMILL®



Default settings .............................................................................................................  64
Options / properties ...............................................................................................  64
Sketcher options ...................................................................................................  64

Data interfaces .............................................................................................................  64
OPEN MIND Software ............................................................................................  64
Import PMI with MBD .............................................................................................  65

Analysis ......................................................................................................................  66
Attributes .............................................................................................................  66

Edit and modify .............................................................................................................  66
Edit ....................................................................................................................  66
Modify .................................................................................................................  69

Points, curves and faces .................................................................................................  69
Drafting ...............................................................................................................  69
Shapes ...............................................................................................................  72

Parametric modeling ......................................................................................................  75
Automatic rebuild on / off ........................................................................................  75

Solids, features and meshes ............................................................................................  75
Features ..............................................................................................................  75
Solid ...................................................................................................................  77
Meshes ...............................................................................................................  77

Design electrodes ..........................................................................................................  77
Electrode options ..................................................................................................  77
Create partial ........................................................................................................  78
Create user defined ...............................................................................................  78
Modify eroding path ...............................................................................................  78
Using user-defined tags for electrode documentation ....................................................  79
Export to EDM ......................................................................................................  79
Preparing generator programs .................................................................................  80

CAM programming ........................................................................................................  80
Overview .............................................................................................................  80
Adaptive construction .............................................................................................  83

Analyzing probing results ................................................................................................  83
Probing tab ..........................................................................................................  84
Import probing data ................................................................................................  87
Probing options .....................................................................................................  87

3. Release notes ...........................................................................................................................  89
Release 2024 .......................................................................................................................  89

CAM ...........................................................................................................................  89
CAD ...........................................................................................................................  93

Release 2024 | Update 1 .........................................................................................................  98
CAM ...........................................................................................................................  98
CAD .......................................................................................................................... 102

hyperMILL®



OPEN MIND has always offered an innovative CAD/CAM solution whose CAD functionalities are seamlessly
linked to CAM programming.

We Push Machining to the Limit
The resulting time savings in workpiece preparation, among other things, make it clear that CAM without CAD
is not an option. From version 2024, hyperMILL® now combines CAD and CAM under one name (instead of
hyperCAD-S), thus consolidating “CAD for CAM” for the future. The familiar CAD functionalities remain the
same, only their names change.
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1. Supported Versions

Operating systems und CAD platforms
64-bit operating systems Windows 10, Windows 11

64-bit CAD platforms hyperMILL®

Inventor 2022, 2023, 2024

SolidWorks 2022, 2023, 2024

Server operating systems (License
server only)

Windows Server 2012 R2, Windows Server 2016, Windows Server 2019

hyperMILL exclusively supports 64-bit operating systems.

Attention: hyperMILL® 2023 is not compatible with any thinkdesign version!

CAD interfaces
The following CAD models can currently be imported and/or exported (depending on the license purchased):

Product File type Up to version Import Export

Technology up to 31 De-
cember 2019

Current technology

CATIA V4 *.mod-
el

4.2.4 4.2.5 x

*.exp 4.2.4 4.2.5 x

CATIA V5 *.CAT-
part

6R2018 (R28) V5-6 R2023 x

*.CAT-
prod-
uct

6R2018 (R28) V5-6 R2023 x

*.CGR Not supported V5-6 R2023 x

CATIA V6 *.3dxm
l

Not supported 2024 x

PTC Creo Paramet-
ric

*.prt

*.prt.
*

6.0 F000 10 x

hyperMILL®
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Product File type Up to version Import Export

Technology up to 31 De-
cember 2019

Current technology

*.asm

*.asm.
*

6.0 F000 10 x

*.neu Not supported 10 x

PTC Creo *.xpr 6.0 10 x

*.xas 6.0 10 x

Siemens NX *.prt NXCR NX2312 x

SOLIDWORKS *.sldp
rt

2019 2024 x

*.slda
sm

2019 2024 x

Autodesk® Inventor® *.ipt

*.iam

2019 2025 x

Rhinoceros® *.3dm Not supported 8 x

Solid Edge *.par

*.asm

*.pwd

*.psm

Not supported 2024 x

PRC (Product Rep-
resentation Com-
pact)

*.prc Not supported All versions x

Parasolid *.x_t 31 36.1 x

*.x_b 31 36.1 x

JT-Open *.jt 10.2 10.9 x

IGES *.igs

*.iges

5.2, 5.3 5.1, 5.2, 5.3 x

5.3 5.3 x

STEP *.stp,
*.step

AP 203

AP 214

AP 242

AP 203 E1/E2a.

AP 214b.

AP 242c.

x

AP 214 AP 214 x

AutoCAD *.dwg 2018 (AC1032) 2019 x

hyperMILL®
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Product File type Up to version Import Export

Technology up to 31 De-
cember 2019

Current technology

*.dxf 2013-2017 (AC1027) 2019 x

Point clouds *.pt,

*.asc

*.xyz

*.txt

No version No version x

*.pt x

Polygon mesh *.stl

*.stla

*.stlb

No version No version x x

3MF Reader

(3D Manufacturing
Format)

*.3mf Not supported 1.2.3 x

ACIS *.sat

*.sab

Not supported 2023 x

Wavefront OBJ *.obj Not supported All versions x
a.(ISO 10303-203) "Configuration controlled 3D design of mechanical parts and assemblies"
b.(ISO 10303-214) "Core data for automotive mechanical design processes"
c.(ISO 10303-242) „Managed model-based 3D engineering“

hyperMILL®

4



Interfaces Tool database
Tool

Management

System

Required licenses Required software

tdm systems TDM Base modul (TDM / TDMGL)

TDM Class / group structure V (CLGR)

CAM Interface TDM - hyperMILL (AME) (iM-
HYP)

Optional for 3D Tool data transfer:

3D-Solid Converter for hyperMILL (iCHYP)

TDM Systems - Base Installer

TDM Systems - Data Installer

TDM Application Server Installer

TDM GlobalLine Interfaces Installer (for the
Smart Interface Client hyperMILL)

Zoller TMS hyperMILL v2 Interface first license

TMS Tool Management Solutions

TMS Tool Management Solutions BRONZE
package

TMS Tool Management Solutions from ver-
sion 1.17.0

WinTool AG WinTool

hyperMILL Interface

WinTool 2020 (WT2020.2.1)

Microsoft Server 2012 or higher

Microsoft SQL Server 2012 or higher

hyperMILL Interface (2.13.5)

Hexagon Manufac-
turing Intelligence

NCSIMUL Tool

NCT‐CAM‐HY (hyperMILL interface)

NCSIMUL Tool

NCSIMUL Tool Client

NCSIMUL Tool Server

NCSIMUL Tool Interface

FlexLM

Supported EDM formats
Reports for the following eroding machine types can currently be converted.

Manufacturer Software Ver-
sion

Output 3-point
path

Virtual electrode Rotating elec-
trode

Output 3D
path

Zimmer & Keim Alphamoduli x x x x

OPS Ingersoll Multiprog x x x

ONA x x x

+GF+HMI AC FORM HMI x x x

Exeron Exoprog x x x

hyperMILL®
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Supported OPTICAM Software Versions
The following OPTICAM software version can be used for the respective hyperMILL® version:

hyperMILL® OPTICAM

2024 | Update 1 2024.2

2024

2023.2 | Update 9 2024.1

2023.2

2023.2 | Update 8 2023.2

2023.12023.2 | Update 7

2023.2 | Update 6

2023.2 | Update 5

2023.2 | Update 4

2023.2 | Update 3

Interfaces NC simulations
VERICUT from version 7.0

NCSimul from version 2020.0

hyperMILL®
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2. New commands and additions
Information on new commands and additions, as an extract from the software documentation:

CAM
User interface
hyperMILL and CAD program

Icon Function Explanatory note

Optimal barrel cutter Optimize parameters of barrel cutters based on sur-
face and curve information.

The hyperMILL browser

Jobs tab

Turning with turret
The following information is available for turning jobs with a turret:

A machine with turret is used in the job list and the definition of the turret setup is free of errors
and warnings.

A machine with turret is used in the job list and the definition of the turret setup contains errors.

A machine with turret is used in the job list and the definition of the turret setup is free of errors
and warnings. No NC file has been created yet.

A machine with turret is used in the job list and the definition of the turret setup contains errors.
No NC file has been generated yet.

A machine with turret is used in the job list and the tool used in the job is set up on the turret.

A machine with turret is used in the job list and the tool used in the job is not set up on the turret.

No machine for turning jobs with a turret has yet been set up in the job list

Basics of CAM editing

hyperMILL®
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Specifying the basic settings

Dialog page CAM Plan
Activate the Project → Activate CAM Plan function to display the CAM plan dialog page in the hy-
perMILL® browser. Select a suitable project template depending on the type of part to be machined.

NC system and frames

Functions on the shortcut menu: Coordinate systems
 Preselect: Preselect the marked origin or frame. This can then be selected directly from the list in the job

definition (see ToolFrame) by clicking the icon . A preselected frame or origin is displayed in bold in the
browser.

 Remove preselection: Cancel the preselection for the selected origin or frame.

Tool management

Define tool

Edit icons in the Tool type dialog

  Optimize barrel cutter parameters.

Optimize parameters of barrel cutters based on surface and curve information so that the
surface to be machined is completely machined as required.

Define tool in a job

Cutting profile
Technology data defined for the tool used in the job is displayed in the cutting profile.

Tools included in a tool series
Profile mode: The cutting profile parameters are defined in the technology template of the tool series. For
information on creating a tool series, see section OPEN MIND tool database → Tool series and Technology
templates.

Select the Static (compatible) profile mode if a type of cut suitable for machining is available for the tool. Then
select this under Type of cut.

Type of cut: The type of cut is taken from the series definition of the tool that is defined in the tool database
for the material used.

Select the Manual profile mode if no suitable type of cut is available for the tool. The parameters of the cutting
profile correspond to the standard parameters of a tool that is not included in any tool series. When switching
from profile mode Static (compatible) to profile mode Manual, the parameters of the previously set type of cut
are transferred to the cutting profile.

Icons in the Tools dialog

Available if a machine with turret for turning jobs is defined in the job list. Only the mounted
tools are displayed in the tool selection list.

Available if a machine with turret for turning jobs is defined in the job list. All defined tools are
displayed in the tool selection list.

Get preselection: Preselect a frame or origin from the list of frames/origins for job definition.

hyperMILL®
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Structure CAM project

CAM Plan

Der CAM-Plan beinhaltet Funktionen, die den Ablauf des Programmierens vereinfachen. Vom Analysieren
des Bauteils, Anzeigen und Reparieren möglicher Flächendefekte bis hin zum automatischen Erzeugen von
Features und für das Programmieren notwendiger Geometrien. Zusätzlich stellt der CAM-Plan eine Plattform
für weiterführende Technologien und mehr Interaktivität beim Programmieren dar. Der CAM-Plan ist eine
Dialogseite im hyperMILL®-Browser, unterteilt in einen Strukturbaum (im oberen Teil) und die Bereiche
Auswahlen und Aufgaben (im unteren Teil).

After activating the CAM plan in the hyperMILL® settings (CAM menu Setup → Settings → hyperMILL settings
→ CAM Plan  → Activate CAM Plan), select a predefined project template. Depending on which template was
selected, the CAM plan contains different functions and tasks.

Use the  /  icons in the structure tree to control the visibility of elements.

To avoid possible issues during programming, all the tasks offered should be carried out.

General (complementary): Control the visibility of all geometries not selected as a part using the  /  icons.

Part: Select the surfaces of the part to be programmed without unnecessary additional surfaces or hole
capping. Then go through the tasks step by step to prepare the part completely.

Remove duplicate surfaces: Check the part for double surfaces and remove them if present.

Check surfaces: Check the selected surfaces for possible defects that could cause problems in the subse-
quent programming process. If a damaged surface is found, the first step is to attempt to repair the surface
automatically. In the next step, a new layer is created, the corresponding surface is moved there and
removed from the selection made in Part. Ensure that this or any newly constructed surface is included in the
part selection again.

hyperMILL® converter check: Check whether the selected part can be converted by the converter.

Check for gaps: Check whether there are gaps between the selected surfaces. If gaps are found, a layer is
automatically created upon which the gaps are displayed using curves and points. Decide whether the gaps
should be corrected or not. Skip this task by deactivating the corresponding option at Computable task.

Orientate surfaces: Check whether the selected surfaces are correctly orientated. After starting the task, the
corresponding CAD function opens automatically and aligns the surfaces. Manually align any surfaces that
are not aligned correctly. The corresponding surfaces are displayed in a dark color.

Hole recognition / add capping: This task starts the Feature mapping based on the selection made for the
Part. Capping surfaces are automatically created for the recognized holes, a new layer is created and the
surfaces are moved there. Skip this task by deactivating the corresponding option at Computable task.

Create milling area(s): The milling areas required for programming are created automatically. Depending
on the selected project template one or two milling areas are created. If a template "with holes" has been
selected, two milling areas are created. One milling area that contains the part and the holes and one milling
area that contains no holes but the capping surfaces. If the "without holes" template has been selected, only
one milling area is created.

hyperMILL®
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HPM Milling: Select all surfaces that are relevant as product surfaces for 3D finishing and create topology in-
formation from them. The curves generated represent the exact topology information of the product surfaces.
They are saved internally and used for the point distribution of 3D finishing.

Create topology information

Generate topology curves for 3D finishing.

hyperMILL® browser → CAM Plan → HPM Milling → Create topology information

Select
Shapes: Select entities  1 .

1

5
3

2 4

Invert orientation: Invert the orientation of the faces of the shape.

Mapping
Select the continuities to be analyzed: Gap 2 , Sharp 3 , Curvature 4 , Tangential 5 . The number of curves
found is displayed. The results are marked with the colors displayed in the dialog. The colors cannot be
changed.

Sharp edges
Search for all, only convex or only concave edges.

Reference values
Tolerance: Enter a value for the permissible deviation in the position for the size of the gap.

Angular tolerance (degrees): Enter a value for the maximum permissible deviation of the tangency of the
transition.

Curvature difference (%): Enter a value for the maximum permissible deviation of the curvature of the
transition.

Deburring: Select all surfaces as edge surfaces that are relevant for deburring the part and generate the
edge geometries for deburring. These curves are saved internally and used for the toolpath calculation of the
cycle 5X Deburring.

Kantengeometrie erstellen

Konturen für das Entgraten ermitteln.

hyperMILL®-Browser → CAM-Plan → Entgraten → Kantengeometrie erstellen

Auswählen
Formen: Elemente auswählen 1 .

hyperMILL®
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1

3 2

Zuordnung
Die zu untersuchenden Stetigkeiten auswählen: Lücke 2 , Scharf 3

Die Anzahl der gefundenen Kurven wird angezeigt. Die Ergebnisse werden mit den im Dialog angezeigten
Farben kennzeichnen. Die Farben können nicht geändert werden.

Referenzwerte
Toleranz: Ein Wert für die zulässige Abweichung in der Position für die Größe der Lücke eingeben.

Max. Entgratwinkel (Grad): Den maximalen Winkel zwischen zwei Flächen eingeben, für die eine zu entgra-
tende Kante erzeugt werden kann. Um alle möglichen scharfen Kanten zu erzeugen, 180 Grad eingeben.

Werkzeugdurchmesser: Einen Durchmesser eingeben, der gleich oder kleiner ist als der kleinste Werkzeug-
durchmesser, der zum Entgraten verwendet werden soll.

The Job list dialog

Job list settings
Compound job IDs/Job IDs: Use Start to define the start ID and Increment to define the incremental increase
of the start ID for compound jobs/jobs.

Probing
Create logs for CAD import: Visualize the measured values generated by the 3D Point Probing cycle in
the CAD system (via the Probing tab). Various filter functions are available. For further information, see the
product documentation for the CAD system.

The Create logs for CAD import function is executed via the VIRTUAL Machining Center.
The prerequisite for this is a corresponding Virtual Machine that is activated in the Job list
→ Postprocessor → Machine → Machine administration dialog and is available for selected
machine controls. Please contact your OPEN MIND dealer to arrange this.

Postprocessor
 Turret setup: If a Virtual Machine with support for turning jobs with a turret is defined as a machine (see

Machine administration → Edit → Machine properties → Virtual Machine Directory), this is symbolized by an
icon. Click the icon to open the Turret setups administration dialog to assign the required Names and, if
required, a Comment for this machine configuration. Click the New button to define a new turret setup. The
following functions are also available: Edit..., Delete..., Copy..., Export..., and Default....

hyperMILL®
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Simulate machining

Machining planner
Start the VIRTUAL Machining Center in Machining planner mode and equip a turret for turning jobs with
graphical support. No toolpaths are loaded. The function is available if, in the job list (Postprocessor dialog
page) a corresponding Virtual Machine has been loaded.

In the VIRTUAL Machining Center, switch to the Configuration operating mode and

open the Turret setup dialog.

Turret setup
Both turret holders and NC tools from the tool database or from hyperMILL® can be imported for turret setup
(1). Double-click in a line and then click on the button (2) to rotate a turret holder and an NC tool around the
Z-axis.

Drilling tool_01
Turret holder_01

Turret holder_02

Turret_holder_03

Turret holder_04

Roughing

Finishing

NC-Tool mountsNameStation

Add turret holder from Tool Database

Add turret holder from hyperMILL

Add NC-Tool from hyperMILL

Add NC-Tool from Tool Database

Shift X Shift Y Tool reach Rotation Z

Drilling tool_02

Station: Position of the tool mount on the turret.

Name: Name of the static holder/NC tool in the location.

NC-Tool mounts: Number of tool mounts of the static holder.

hyperMILL®
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Shift X / Shift Y: Offset between the coordinate system of the Machine side coupling (1) and the Work piece
side coupling (2) of the static holder in the X or Y direction.

(A) Turret, (B) Turret holder, (C) NC tool.

1

12

2

A

A
Z

Z

Z

Z

Z

Z
X

X

X

X

X

X Y

Y

Z
X

Y

Y

x
Z

B

B

CC

Tool reach: (1) Section of the NC tool (measured up to the tool tip) that sticks out of the turret holder.

Rotation Z: (2) Rotation of the NC tool or the turret holder around the Z-axis. The turret holder is rotated in
90° steps and the NC tool in 180° steps.

hyperMILL®
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hyperMILL additional functions

Rest material display

Display remaining rest material for visual analysis.

CAM browser → Jobs → Shortcut menu → Utilities → Rest material display 2024

Display remaining rest material for visual analysis. A comparison of the pre-calculated current machining
status with a workpiece is carried out and the differences are displayed. A current stock chain is required for
this.

Color/rest material thickness
Color: Double-click with the left mouse button on the color field in the table to open the dialog for changing
the color of the interval.

Rest material thickness: Double-click with the left mouse button on a table row to change a value of the
interval limit.

Limits
Minimum rest material that is taken into account in the rest material display. Maximum rest material that is
taken into account in the rest material display. Enter Min. and Max..

Example: Default values for color and rest material thickness

hyperMILL®
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1

5

32

4

1

5

3
2

4

Tolerance
Model geometry: Value for the accuracy of the rest material display.

Update: Update the display of the rest material.

More options
Number of intervals: The rest material is displayed in five intervals. A higher value increases the fineness of
the display.

Exact computation: Refine the calculation of the rest material display. The calculation is performed automati-
cally in relation to the size of the workpiece.

Turning
Roughing

Strategy

Options
Ring removal: Remove ring chips from material breakthroughs. Finished surfaces are protected and process
reliability is improved. The function is executed instead of the defined macro, and only if there are material
breakthroughs. It is supported for the Axial roughing strategy in combination with all cutting side options, and
for the Radial roughing strategy only in combination with the Plane machining function.

(1) Ring removal is activated, (2) Ring removal is not activated.

X

Z

X

Z

1 2

hyperMILL®
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High Performance

Chip thickness control
The Chip thickness control function ensures that the chip thickness remains as constant as possible during
machining, thus guaranteeing reliable chip breaking during lead in and retraction and at shallow cutting
depths.

Use the two parameters Min. feedrate and Max. feedrate to define the range for adjusting the feedrate. The
target chip thickness is calculated from the feedrate of the tool (see cutting profile of the tool).

1) Chip thickness control is activated, (2) Chip thickness control is not activated.

Feedrate analysis with the function CAM → Analysis toolpath → Feedrates by color map.

1 2

From To Color
G0 movements to.... 1.95

2
1
1.239
1.16
1.081
1.002
0

1.95
2
1
1.239
1.16
1.081
1.002

Grooving

Strategy

Options
Finish path: (2) Removal of machining marks from the previous roughing operation (1).

12 2

hyperMILL®
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Drilling
Optimized deep Hole Drilling (new)

Process
The process sequence of the tool is controlled in eight phases. For each phase, the Spindle orientation,
Feedrate, spindle speed (), Coolant, and Dwell time can be defined.

Phases
Spindle: Use and to define the spindle orientation or to define a spindle stop.

For threading into the pilot hole (phase 1) and when retracting to the start of the pilot hole
or to the clearance distance (phase 7/phase 8), the orientation of the spindle is set to by
default.

Feedrate / : The values for and Spindle speed are taken from the definition of the tool in the OPEN MIND
tool database. They correspond to the values set in the job definition on the Tool tab under Cutting profile. To
adjust both values, enter the % value in the Feedrate and columns.

To manually overwrite the values for Feedrate and that are preset in the tool definition,
right-click the value in the required Phase, select the Disconnect option, and enter the
required value.

The value is now displayed in bold , the definition in the tool and the adjustments in the
Feedrate / column are no longer taken into account.

To establish a new connection between feedrate/spindle speed and % values and to the
tool definition, right-click the modified value and select the Link option.

Coolant: Define the coolant for each phase.

Dwell time: Define the dwell time in seconds for each phase.

hyperMILL®
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Movement sequence of the tool

Feedrates and spindle speeds assigned to the tool during its movement:

(1a) Guide sleeve: rapid movement up to the start of the guide sleeve; with F1 and S1 until the end of the
guide sleeve.

(1b) Pilot hole: rapid movement up to the clearance distance. With F1/S1 until the end of the pilot hole.

(2) With F2/S2 until the start of the crosshole.

(3a) Crosshole: from the start of the crosshole until the end of material removal with F3/S3. For crossholes
with F4/S4. From the start of material removal until full material removal with F5/S5. (3b) Crosshole: for
continuous material removal in a crosshole: until the end of the crosshole/material removal with F6/S6.

(4) Outlet for a through hole/crosshole) with F3/S3 or F4/S4.

Retract movement: to the clearance distance or the start of the guide sleeve in F7/S7.

Linking movements: between drill holes with F8/G0 and S8 (reduced feedrate/spindle speed).

Additional feedrate settings
Stepwise feedrate increase: Enable the option to gradually increase the feedrate values between F1 and
F2, F6 and F2, as well as F4 and F2. The Length defines the total length of the stepwise feedrate increase
(default = tool diameter * 1.5). The Number of steps determines how often the increase takes place in the
defined Length.

Process: end of hole
Dwell time: Time in seconds for which the drill remains on the hole bottom to cut material free.

Incremental retract: Define a retract movement to retract the tool at the end of the dwell time on the hole
bottom in a defined retract length and with a defined Retract feedrate. This prevents possible damage to the
tool during direct retraction with F7 from the hole bottom.
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Retract length: (1) Specify the length of the incremental retract movement.

Retract feedrate: Specify the feedrate of the incremental retract movement.

F7
S7

1

Parameters

Cross hole safety
Clearance distance: To ensure a safer drilling process, the phases 3 and 5 (cross drilling without material
removal) or the phase 6 (cross drilling with material removal) are each extended at the beginning and end by
the amount of the clearance distance (1).

Examples:

Cross drilling without material removal: Phases 3 (A) and 5 (B) start earlier and end later. Phase 4 is
shortened by the corresponding amount. (1) = Clearance distance.

A

B
1

1

1

1
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Cross drilling with material removal: Phase 6 starts earlier and ends later. (1) = Clearance distance.

1

1

Machining parameters
Chip break: Activate if a chip break is to take place.

Initial pecking depth: Infeed depth in the first drilling stroke, that is, when entering the hole (without pilot hole
and guide sleeve).

Pecking depth: Infeed depth of the drilling strokes performed after the initial drilling stroke.

Min. infeed depth: Minimum infeed depth in a drilling stroke if a Reduce value is defined.

Reduce value: Amount by which the pecking depth is reduced for each drilling stroke (after the initial infeed).
Zn+1 = Zn – Reduce value.

Incremental retract: (A) Incremental retract after each drilling stroke. (1) Initial pecking depth. (2) Pecking
depth. (3) Retract value.

Complete retract → Retreat to pilot depth: (B) Complete retraction after each drilling stroke to pilot depth.
Make sure that the tool does not leave the hole completely, as there is a risk of tool breakage. The tool
remains in the hole with Tip angle length + additional clearance.

(1) Initial pecking depth. (2) Pecking depth. (4) Retract to pilot depth.

Complete retract → Retreat to top: (C) Complete retraction after each drilling stroke to the top edge of the
hole. Make sure that the tool does not leave the hole completely, as there is a risk of tool breakage. The tool
remains in the hole with Tip angle length + additional clearance.

(1) Initial pecking depth. (2) Pecking depth. (5) Retract to top.

(D) = Lead in feedrate. (E) Retract feedrate.
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Retract feedrate: Feedrate for retraction of the tool during the chip break (without consideration of cross
holes).

Lead in feedrate: Feedrate for re-entry of the tool during the chip break (without consideration of cross holes).

Setup

Model
Definition of the collision checked part of the CAD model. For further information, see section Collision check
preparations.

Additional surfaces: Temporary safety surfaces to avoid unnecessary rapid travel movements.

For information on the holder/spindle clearance, see section Check tool.

NC parameters
Accuracy : Defines the quality of the model (mesh) against which the check takes place.

Stock
Use the Enable stock option to optionally define a stock that is required to detect breakthroughs and/or cross
holes.

2D Machining
Contour Milling on 3D Model

Contours

Technology

Feedrate options
Edge control: Optimize the feedrate at edges. Two parameters limit the reduction/increase of the feedrate:
Min. feedrate (factor) and Max. feedrate (factor). The factor value refers to the standard feedrate at the
reference point of the tool and controls the feedrate at the contact point. Permissible values for the Min.
feedrate (factor) are between 0 and 1, for the Max. feedrate (factor) between 1 and 10.
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Chamfer Milling on 3D Model

Contours

Options
Overlap off: Select this option when the tool should not perform an overlap on the closed contours.

Smooth overlap: Select if the tool is to perform a smooth overlap on the closed contour. Define the Length (2)
of the overlap. Use Distance (3) to define the maximum lateral distance of the tool from the model during the
overlap.

(1) Start point

(4) = Toolpath points: are shown when this is activated on the General dialog page (in the Toolpath visualiza-
tion area).

1 2

3

4

1

4

Standard: Select this option when the tool should perform an overlap on the closed contours. Define the
Length of the overlap (2).

3D Machining
Profile Finishing

Setup

Tolerance parameter
Tolerance use cases: Use the parameters of the tolerance use cases to ensure the best possible tolerances
depending upon the individual machining situation. The best settings are automatically used based on the
tool diameter and the selected Use case (Semi finishing, Finishing, Fine finishing, Micro finishing).

For Mode specify whether the toolpath is calculated in Standard mode or in High-precision surface mode. The
available use cases represent the typical machining steps during a milling operation.

High precision surface mode: Use when maximum accuracy is required to calculate the toolpath. The calcula-
tion of the toolpath is not based on the faceted model geometry, but on the real surfaces of the model. Only
available for Ball mill.

True Shape point distribution: Activate to redistribute points and guarantee an even and machine control-
friendly distribution of points.
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To guarantee the best possible point distribution, use the CAM Plan function. The machin-
ing cycle automatically takes into account the topology information that was created with
the HPM–Milling task in the CAM plan.

Filter points: Points that are located on straight toolpath sections, for example a planar surface, and are
therefore not required, are filtered out.

Function is not activated (1), Function is activated (2)

1 2

Please note that no or fewer points are not always the best solution for all machine con-
trols. For more detailed information, please contact the respective machine manufacturer.

Cross align points: Align the points across the entire toolpath perpendicular to each other (i.e. at right angles
to the toolpath direction).

Function is not activated (1), Function is activated (2)
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1 2

Feedrate adaption: Activate to automatically adjust the feedrate depending on the curvature of the part. The
feedrate is reduced for concave curvatures (1) and increased for convex curvatures (2). This means that the
real contact feedrate of the tool on the part surface remains constant.

Function is not activated (1), Function is activated (2)
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3D path compensation: Available for the Ball mill tool type. Enables various NC controls to machine the
model with a smaller or larger tool than actually programmed in hyperMILL®. In addition to the X, Y and Z
coordinates, the direction vectors I, J and K to the surface contact point must also be known.

Protect edges: When using the CAM plan, edges on the part are treated so that they are not damaged during
machining. This is achieved by inserting additional points in areas where sharp edges were previously found
in the component using the HPM Milling task.

The 3D path compensation function is available only with a specially adjusted postproces-
sor. Without this adjustment, the NC program cannot correct this output and, as a result,
both the component and machine may be damaged if the milling geometry used differs
from the milling geometry used to calculate the toolpath. To adjust your postprocessor,
please contact your OPEN MIND partner.
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Tolerance settings
In the tolerance settings, adjust the parameters of the True Shape point distribution and Feedrate adapta-
tion functions.

Activate True Shape point distribution to guarantee an even and correct point distribution in toolpaths. The
parameters Calculation tolerance, Max. chordal error, Max. G1 length,  Min. G0 distance, Reference G1
length, control the arrangement and distances between the points.

Use the Adjacent sync. ISO parameter to achieve asynchronous point distribution between individual toolpath
segments by entering a (factor) value less than 1.

Function is not activated (1), Function is activated (2)

The Min. feedrate (factor) and Max. feedrate (factor) define the upper and lower limit for the feed rate
adjustment. The factor refers to the standard feedrate defined for the toolpath. Use Number of steps to
control in how many intervals the increase or decrease of the feedrate adaption is performed.

Z Level Shape Finishing

Strategy

Undercut machining
Supported tool types for undercut machining: Lollipop, T-Slot Cutter, and Woodruff Cutter.

Undercut machining: (1) Enable to machine the model completely.

Undercut machining only: (2) Enable to only machine the undercut area.

X

Z

X

Z

1 2

Plane Machining

Parameters

Pocket mode
Two methods are available for calculating the pocket toolpaths. Use the  High feed mode (1)  to realize
large side infeeds and machine pockets with islands. Preferably use the Standard mode (2) with smaller side
infeeds and consequently fewer repositioning movements.
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1 2

Toolpath fillets
Fillet radius: Abrupt changes in direction within the cutting toolpaths are rounded. The value defined in the
user interface is used to round the toolpaths that are in (lateral) contact with the model (1). The toolpaths that
are not in (lateral) contact with the model are automatically rounded on the basis of the tool diameter (2).

1
2 2

1

Cutting edge

Strategy

Interior corners
Fillet interior corners: Smooth filleting (rounding) of internal milling paths for pockets or islands.

Reduce corner feedrate: The interior corners are machined at a lower feedrate to protect the tool. The
reduced feedrate is defined in the tool database as a technology parameter. This can also be adjusted for a
specific material in a cutting profile.

Smooth overlap
Use smooth overlap: Enable if the tool is to perform a smooth overlap. Define the Area length (2) of the
overlap. Use Distance (3) to define the maximum lateral distance of the tool from the model during the
overlap.
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3
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1

4

5X Machining
Cavity Milling

Radial machining

Strategy

Other infeed options
Use the other infeed options to define the type of horizontal stepover between the end point of one milling
path and the start point of the following milling path. The infeed options can be combined with all infeed
strategies (Along axis, Offset Normal, ... and so on). In the following figures, the Along axis infeed strategy is
used to visualize the infeed options.

Zigzag direct (1), Zigzag smooth (2): The machining direction changes after each passed profile. An ap-
proach macro is used for the infeed to the first milling path and a retract macro is used for retraction after
the last milling path. The Zigzag direct option connects the individual paths directly to each other. The Zigzag
smooth option connects the individual paths with a fillet.
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21

Oneway: The milling direction remains the same over the entire machining area. The infeed from the end
point of one path to the start point of the next path is diagonal. 12

3

Oneway Outside-in (4) / Oneway Inside-out (5): The milling direction is the same over the entire machining
area. Machining takes place using either climb milling or conventional milling.
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4 5

Halfpipe Machining

Strategy

Geometry type
The cycle supports the following geometry types: (1) 2 open ends, (2) 1 open end, (3) No open end, and
Infinite (4).

Strategy

Infinite

Graphic Strategy Description/advantages

Across / Oneway outside-in Plunge machining. Especially for
tools with a short cutting edge.
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Graphic Strategy Description/advantages

Across / Oneway inside-out Drawing machining.

Small tilt angles result in longer
contact on the cutting edge on the
one hand and less contact with
the tool tip on the other hand.

Across / Zigzag Due to the shorter distances be-
tween the paths, the total length
of the toolpath is shorter.

If pull / plunge cut does not play a
role.

Along / Oneway outside-in Similar to a halfpipe with two open
ends, alternating machining takes
place for each infeed between
both sides with linking paths at the
start position.

Advantageous if circulating ma-
chining is not possible - e.g. due
to axis limitations.

The strategy can be used for
roughing, as both sides are ma-
chined simultaneously from the
outside to the inside. Select Diam-
eter of the tool and Allowance to
achieve a sensible path distance
between the left/right side. Use
Start offset to move the first infeed
outwards in order to achieve ac-
ceptable cutting conditions.

Along / Oneway inside-out

Along / Spiral outside-in
First, continuous machining takes
place on the selected start side.
Then machining switches to the
opposite side.

Advantageous if machine tool and
clamping allow circulating machin-
ing.
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Graphic Strategy Description/advantages

Along / Spiral inside-out

Boundaries
The selection of Boundaries (1) depends on the geometry type of the forming groove. The following are
permitted for the geometry type

• No open end A closed boundary around the central curve (A)
• 1 open end An open U-shaped boundary around the central curve (B)
• 2 open ends Two open boundaries on both sides of the central curve (C)
• Infinite Two closed boundaries inside and outside the central curve (D)

(2) = Central curve.

A B C D

3

3

1 1

1

1

11
2 2 2 2

The profile selection has been technologically improved for the 5X Halfpipe Machining
cycle. The selection

• is saved in full and generates an error message if the number of profiles or profile type is
incorrect.

• can be subsequently edited to close missing areas or remove elements selected by
mistake.

Additive Manufacturing

Strategy

Reference path options
Layer: Group of toolpaths at the same Z depth or at the same distance from the drive surface. The number is
independent of whether an infill takes place or not (see options under Additive → Infill).

Use Number layers to skip to define the number of layers that do not generate any additive toolpaths (1) and
Max. number of layers to define the maximum number of layers that are created (2).

Group: If  Infill is activated a pocket (including islands - if present) and an open contour are regarded as a
toolpath/group. If Infill is deactivated, each contour is considered a toolpath/group.
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Use Number paths to skip to define the number of paths that do not generate any additive paths (1) and Max.
number of paths to define the maximum number of toolpaths that are created (2)

1

2 3

2

Tube Milling

Strategy

Tube Roughing

Lateral infeed strategy
There are two directions available for the lateral infeed inside each level.

Toward central curve: (A) The tool moves in a spiral along the surfaces of the tube to the next plane and then
removes the material in the direction of the central curve.

Away from central curve: (B) The tool moves along the central curve to the next plane and then removes the
material from the central curve in the direction of the surfaces of the tube.

A B

If the  Away from central curve strategy is applied, it must be ensured that the tool can
enter along the central curve, e.g. by means of drilling.

Tube Finishing
The following functions are only available in the Tube Finishing cycle.
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Tube Rest Machining
The following functions are only available in the Tube Rest Machining cycle.

Multiblade Milling

MB Roughing

5 axes

Lead angle up / Lead angle down
Smooth factor: The smooth factor can be used to limit the length/smoothing of the transition between the
global and local tool axis settings. This makes it possible to control the area of the drill or upward cuts for both
cutting directions independently of each other.

Not activated: Global smoothing between the setup at all positions that are shown in the UI. The global value
is applied at positions without manually specified local value.

Enabled: Changes the lead angle from the global to the local value and back within a length of factor * tool
radius. With a small factor, the transition between the specified lead angles can be relatively hard. A larger
factor makes the transitions smoother, but can lead to longer drill or upward cuts.

MB Hub Finishing

5 axes

Lead angle up / Lead angle down
Smooth factor: The smooth factor can be used to limit the length/smoothing of the transition between the
global and local tool axis settings. This makes it possible to control the area of the drill or upward cuts for both
cutting directions independently of each other.

Not activated: Global smoothing between the setup at all positions that are shown in the UI. The global value
is applied at positions without manually specified local value.

Enabled: Changes the lead angle from the global to the local value and back within a length of factor * tool
radius. With a small factor, the transition between the specified lead angles can be relatively hard. A larger
factor makes the transitions smoother, but can lead to longer drill or upward cuts.

Tool database
Define turning tool

Define static holder
Turret holder (static/driven) and Guide sleeves are supported.

1. On the Static Holders tab, select the New → Turret holder/Guide sleeve function via the shortcut menu.
2. Under General → Type, select an option (static / driven) for the turret holder, Name, and define a

Comment if necessary. Select a Manufacturer from the list, the Ordering code is inserted automatically.
3. In the Technology area, define the factor values for the speed, feedrate, infeed width and infeed length,

as well as the maximum spindle RPM and maximum feedrate.
4. In the Couplings area, select the Machine side coupling and the Work piece side coupling.
5. Under Geometry → Geometry, click the icon  to start the TOOL Builder to import 3D data for creating

a static holder. For further information, see section Turning tool: Create static holder in the product
documentation for the TOOL Builder.

Create indexable cutter
The indexable cutter tool type is supported as Indexable high feed cutter and Indexable round insert cutter in
hyperMILL®. It is made up of the Insert and Holder components. An indexable cutter is created in two steps.
In the first step, a 3D model is used to generate a rotation contour for the insert and a rotation contour for the
holder; in the second step, the two rotation contours are combined to form a tool.

Indexable cutter with high feed inserts
To create an indexable cutter with high feed inserts, proceed as follows:
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Create rotation contours in the CAD system

1. Use the CAD function File → Open to import a 3D model (*.iges, *.step) of the tool.
2. Create a rotation contour with the CAD function Curves → Shape contour. To do this, activate the Precise

options in the Shape contour dialog, use the functions Rotation and Direction → Z WP, and select the
geometry of the base body with Select → Shapes. Confirm the selection.

3. Then hide the holder and insert geometry so that only the shape contours are shown.
4. Extend the contours of the inner planar surface to the center of the tool adaptor.
5. Check the generated geometry with the CAD function Analysis → Double entities. If there are duplicate

elements, delete them.
6. Check the dimensions of the tool with the CAD function Analysis → Bounding box. The tool dimensions

(diameter, length) must match the tool manufacturer’s data.
7. Use the CAD function Drafting → Sketch to generate a vertical line as a reference for aligning the insert

later.

Example: (A) = Base body, (B) = Rotation contour holder, (C) = Rotation contour insert

A
B

C

Y

X

31 2 4 7

Assemble tool in the CAM system

8. Use the Tools → New CAM function to create an Indexable high feed cutter and select the previously
generated rotation contour for the holder in the tool dialog under Body geometry with the  icon.

9. In the same dialog, select the rotation contour for the insert in Insert geometry with the  icon, and
select the previously created vertical line (see job step 6) to align the insert.

10. Finally, enter the values for Diameter and Length in the Indexable high feed cutter dialog (tool manufac-
turer’s data sheet). The tool dimensions (diameter, length) must match the tool manufacturer’s data, see
job step 6.

11. The tool has now been created and can be used in hyperMILL®.

Indexable round insert cutter
To create an indexable cutter with round inserts, proceed as follows:

Create rotation contours in the CAD system

1. Use the CAD function File → Open to import a 3D model (*.iges, *.step) of the tool.
2. Create a rotation contour with the CAD function Curves → Shape contour. To do this, activate the Precise

options in the Shape contour dialog, use the functions Rotation and Direction → Z WP, and select the
geometry of the base body with Select → Shapes. Confirm the selection.

3. Then hide the holder and insert geometry so that only the shape contours are shown.
4. Extend the contours of the inner planar surface to the center of the tool adaptor.
5. Check the generated geometry with the CAD function Analysis → Double entities. If there are duplicate

elements, delete them.
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6. Check the dimensions of the tool with the CAD function Analysis → Bounding box. The tool dimensions
(diameter, length) must match the tool manufacturer’s data.

Example: (A) = Base body, (B) = Rotation contour holder, (C) = Rotation contour insert

31 2 4

B
C

A

Y

X

Assemble tool in the CAM system

7. Use the Tools → New CAM function to create an Indexable round insert cutter and select the previously
generated rotation contour for the holder in the tool dialog under Body geometry with the  icon.

8. Finally, enter the values for Diameter, Length, and Corner radius in the Indexable round insert cutter
dialog (tool manufacturer’s data sheet). The tool dimensions (diameter, length, corner radius) must
match the tool manufacturer’s data, see job step 6.

9. The tool has now been created and can be used in hyperMILL®.

Optimal barrel cutter

Optimize parameters of barrel cutters based on surface and curve information.

CAM → Optimal barrel cutter

CAM browser → Jobs → Job → Tool: Select a barrel cutter. A function for optimizing
the barrel cutter is displayed in the tool definition. 2024

For machining with barrel cutters, the optimal shape of the barrel cutter must first be found. This ensures that
the surface to be machined is completely machined as required. The parameters of the required barrel cutter
are optimized on the basis of surface and curve information. A surface and several curves in relation to this
surface are included in the analysis. Preset values for the dimensions of the barrel cutter are taken from the
tool definition in hyperMILL® when called.

Select
Surface: Select the surface for which an optimal barrel cutter geometry is to be found for machining.

Curve: Select one or more curves in relation to this surface that represent the planned machining path. The
number of selected elements is displayed.

Barrel
When calling the dialog from the hyperMILL® job definition (Tool dialog page) and selecting a barrel cutter,
the Cutter parameters of the selected tool are adopted. The parameters can then be changed manually.

For Base diameter range and Barrel radius range, enter the minimum and maximum values between which
the optimal value is to be calculated. All other parameters are considered fixed when the calculation is
running.
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Both the variables and the fixed parameters are included in the calculation of the optimal barrel radius and
base diameter.

If the dialog is started via the CAM → Optimal barrel cutter menu, preselect an option for a
conical, tangential or general barrel cutter for Barrel type and an option (ball, radius, sharp)
for Tip type.

   If the dialog is started via the hyperMILL® job definition (Tool dialog page), these
parameters are already preset and can no longer be changed.

Options
Contact parameter: Enter how the preview of the tool contact point of the barrel cutter should be positioned
in relation to the selected curve. For example, if the value 0.5 is entered, the tool preview is displayed at the
center of the curve.

Create 3D: Create a 3D model of the calculated tool geometry in the graphics area.

Verification

• Single curve: Select an individual curve to specify where the tool preview should be displayed. Enter a
value or vary it using the slider. The determined tool geometry is moved along the curve

• Use Face offset to enter a value that enlarges the internal tool shape to allow a preview of the contact area
between the tool and the surface. The smaller the value, the smaller the preview.

Further options
Cutting side: Change the tool position in relation to the surface normal of the selected surface (inside or
outside).

Infeed direction: Reverse the infeed direction of the tool in relation to the orientation of the selected curve.

Automatic computation: The optimal tool geometry is displayed as a preview for the set values and only in the
slider position that defines the contact parameter.

Global mode: If Global mode is selected for the calculation, every point in the selected curves is taken into
account so that the optimal tool shape is calculated within all selected curves. Depending on the geometry,
the calculation may take some time. Otherwise, or if the slider is moved, the calculation is performed continu-
ously for each point currently reached. When the slider stops, the result is updated. Different tool dimensions
are obtained for the various points analyzed on the curves.

Result
Optimal barrel radius: The determined maximum possible barrel radius that fits the area is output.

Optimal barrel diameter: The determined maximum base diameter (shaft side) that fits the surface is output.

The function does not carry out a collision check! This is performed in the cycle. The
optimum shape is determined using an analytical calculation on the selected surface,
taking into account a safe tolerance, in order to obtain the best possible shape.

Current restriction: Currently, the tool is always considered normal to the curve during the
calculation. A lead angle is expected to be introduced with one of the next versions.
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Tool series and technology templates

Definitions

Tool series A Tool series can only be created in the Tool type view and comprises one or
more tools of the same type. As the technology in the tool series is defined for
all tools, a series should only contain tools that have the same purpose. The
names and comments for the individual tools can also be defined in the tool
series using a pattern.

Technology template A Technology template contains a Type of cut for a Cutting class or a Concrete
material that can be machined with the tools in the tool series.

Cutting class A Cutting class is a virtual material (that is, a type of reference material)
that is superordinate to a group of concrete materials with similar machining
properties (machinability, hardness, and so on).

Concrete material A Concrete material is a single material that belongs to a specific cutting class.
The assignment is based on machinability.

Type of cut Each Type of cut contains predefined, application-related technology param-
eters that can be defined via constant values, calculation rules, or sample
tables.

For further information, see section Type of cut parameter and associated
calculation rules.
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User interface
(1) List of tools in a tool series in the tool browser under the tool type view

(2) Overview: features of the tool series

(3) Definition and overview of the technology templates (materials and types of cut)

(4) Material definition, (5) Type of cut definition

(6) List of materials in a tool series

(7) List of tools in a tool series

Define tool series
To define a tool series, proceed as follows:

1. On the Tools tab of the database, show the Tool type view, select the required tool type and choose New
→ Tool series from the shortcut menu.

2. Define a unique Name and, if necessary, a Comment for the tool series. Define the measurement
system, the standard Cutting edges, and the Spindle orientation of the tools to be saved in this tool
series.

3. Tool names and tool comments can (optionally) follow a defined pattern. Click the line Tool name pattern
and Tool comment pattern and then click the icon  to compile the required name pattern from the
available elements.

4. If available, select the tool manufacturer from the list under Manufacturer. This must be created in
advance in the Edit manufacturers dialog.

Pattern format for tool name and comment
Specific number formatting (for example, for diameter, length, and so on) is permitted to define the pattern for
the tool name and the tool comment. The following characters are permitted for formatting numbers:

“#”: Serves as a placeholder for digits of the number that can be discarded. Leading and trailing zeros can be
discarded.

“0”: Serves as a placeholder for digits of the number that are to be filled with “0” if they are not present. If they
are present, the digit from the number is used.

“.”: Used as a decimal separator if a “.” is required as the display style.

“,”: Used as a decimal separator if a “,” is required as the display style.
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Tool name pattern Example:

<TOOL_SERIES> D <TOOL_DIAMETER format ="00.000" decimal-separator=".">

Tool type

Tool series name

D = 8
D = 6,3

D = 10
D = 10,45
D = 12,7334

Tool diameter
Tool diameter
Tool diameter
Tool diameter
Tool diameter

Ball Mill

Ball Mill - Titanium

Ball Mill - Titanium D 06.300 (Ø6,3 R3,15 L24)
Ball Mill - Titanium D 08.000 (Ø68 R4, L75)
Ball Mill - Titanium D 10.000 (Ø10 R5, L30)
Ball Mill - Titanium D 10.450 (Ø10,45 R5,225 L40
Ball Mill - Titanium D 12.733 (Ø12,733 R6,37 L72)

MEASUREMENT SYSTEM CONVERSION IN PATTERN
It is possible to display the geometry values of the tool in a measurement system other
than the one selected in the tool series. To do so:

unit="<measurement units>"

Add to the pattern (measurement units are “in” or “mm”). For example, to display the tool
diameter 9.525 mm in inches (0.375) in the metric measurement system, use the following
pattern for the tool name:

<TOOL_DIAMETER unit="in">

Example: Tool name pattern

Tool type

Tool series name
Tool diameter D = 6,35

D = 9,525
D = 12,7

Drill Tool

Drill Tool - Steel

0.25 (Ø6,35 L 100)
0.375 (Ø6,3 L 100)
0.5 (Ø12,7 L 100)Tool diameter

Tool diameter

<TOOL_DIAMETER unit="in">

Add a new tool to a tool series
To add a new tool to a tool series, proceed as follows:

1. On the Tools tab of the database, show the Tool type view and select the required tool type.
2. Select the required tool series and choose New → New tool on the shortcut menu.
3. Name and Comment are assigned automatically if a corresponding name scheme has been defined. The

tool type, tool series, number of cutting edges, measurement system, and manufacturer are taken from
the tool series.

4. Define the required geometry parameters.

The technology of the tool is defined in the Technology templates. The parameters cannot be changed on the
tool.

Add an existing tool to a tool series
To add an existing tool (for example from a previous version of the database) to a tool series, proceed as
follows:
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1. On the Tools tab of the database, show the Tool type view and select the required tool.
2. While holding down the left mouse button, drag the tool to the entry for the required tool series and

release the mouse button (drag and drop).

Please note that all technology data of an existing tool is discarded when the tool is added
to a tool series.

Define technology template
A tool series can contain several technology templates. Each technology template comprises a material and
an assigned cutting type.

Proceed as follows to define a technology template:

1. In the Technology area, click the  icon (1) to add the required Material.
2. Click the name of the material and then click the  icon (6) to add a Type of cut for the material. The

types of cut available depend on the tool type in the tool series.

Edit type of cut
Each type of cut consists of a Parameter set and a Calculation rule for each parameter. Click the name of the
type of cut and then click the  icon (8) to open the Edit type of cut dialog.

Other functions
(2) Delete a material and all assigned types of cut. (3) Copy the data of all technology templates to the
clipboard (3) or paste them from the clipboard (4). (5) Define a scaling for rule parameters. (7) Delete a type
of cut. (9) Lock a technology template to prevent unintended changes or to exclude it from scaling.

Technology

Plunging

Roughing

Material Steel

Type of cut

Ramp plunge

Standard roughing

Cutting class

Priority

Steel < 500N/mm2

Score

1 2 3

6

8
7

4

9

5

The parameters of the type of cut cannot be changed, only the calculation rule assigned to a parameter, and
the associated values. To do this, select the required rule in the Calculation rule (1) column and specify using
the available methods.
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1

Edit type of cut - Steel 500 - 850 N/mm2 

Parameter Calculation rule

Constant 0° 
0,6 
20 m/minConstant

ConstantCoolant

Plunge angle
F/edge (fz)

Cutting speed (Vc)
Tool diameter * factor 

SCALE RULE PARAMETERS

- + Use the Scale rule parameters to scale the value of the selected parameters.
The factor value applies to all types of cut of the selected material if the Type
of cut is not locked.

To derive a new material from an existing material, copy the existing material
with all types of cut and then scale all parameters using the Scale rule parame-
ters function.

Type of cut parameter and associated calculation rules
Type of cut parameters are tool technology parameters that are required in a hyperMILL® job or are neces-
sary to calculate the technology parameters. Only the type of cut parameters that are actually required are
available. The following table contains all the type of cut parameters that can be defined in hyperMILL® and
their calculation rule(s).

Type of cut parameter Calculation rule

Axial feedrate: Feedrate for axial G1 movements,
usually at the start of machining (clearance dis-
tance to the first toolpath point).

Feedrate * factor

Coolant: Call the coolant (multiple selection possi-
ble). The call of the coolant must be created global-
ly in advance using the Edit coolants function.

Constant

Cutting speed (Vc): Calculation of the spindle
speed, depending on the tool diameter.

Constant

Tool diameter sample table

Tool diameter and corner radius sample table
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Type of cut parameter Calculation rule

F/edge (fz): Feedrate for each tool cutting edge for
calculating the machining feedrate.

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Standard chip thinning formula

Feedrate per edge formula

F/edge max.: The parameter F/edge (fz) always re-
fers to a specific Infeed depth (ap). If a value lower
than the defined value for the infeed depth (ap) is
used, the feedrate can be increased. This feedrate
adjustment can be limited using the F/edge max.
parameter.

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

If there is no value for the F/edge max. parameter, use the same value as for the
F/edge (fz) parameter.

The parameter is not currently used by hyperMILL®. The definition with meaningful
values is necessary for future functions and is therefore made available in advance.

Plunge angle: Plunge angle for helical or ramp-sha-
ped movements.

Constant

Tool diameter sample table

Tool diameter and corner radius sample table

Infeed length max: Maximum length with which the
cutting edge of the tool may be engaged when
plunging.

Cutting length * factor

Tool diameter * factor

F/edge full cut: Feedrate for each tool cutting edge
in full cut.

Standard material removal rate * factor

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

F/edge plunge: Feedrate for each tool cutting edge
for helical or ramp-shaped movements when plung-
ing.

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Infeed width (ae): Lateral infeed. Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table
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Type of cut parameter Calculation rule

Infeed depth (ap): Vertical stepdown. Cutting length * factor

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Cutting speed plunge: Cutting speed (Vc) for cal-
culating the spindle speed during plunging move-
ments, depending on the tool diameter.

Constant

Tool diameter sample table

Tool diameter and corner radius sample table

Infeed width min/Infeed width max: Only available
for the Trochoidal roughing type of cut.

Define the range for the minimum and maximum
infeed width in which the infeed width (ae) may be
located.

Tool diameter * factor

Infeed length min: Minimum vertical length with
which the tool must be engaged.

Cutting length * factor

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

The parameter is not currently used by hyperMILL®. The definition with meaningful
values is necessary for future functions and is therefore made available in advance.

Cutting speed reference: Cutting speed reference
value for calculating the Cutting speed (Vc) using
the Standard adjusted speed formula or Cutting
speed formula calculation rules.

Constant

Tool diameter sample table

Tool diameter and corner radius sample table

F/edge reference: Reference value for the feedrate
for each cutting edge for calculating the chip thick-
ness.

Tool diameter * factor

Tool diameter sample table

As technology data is generally available for conventional roughing strategies with large
lateral infeed, the feedrate is adjusted based on this reference technology and in rela-
tion to the Infeed width (ae) parameter. The chip thickness is retained.

Infeed width reference: Reference value for the in-
feed width for calculating the chip thickness.

Tool diameter * factor

As technology data is generally available for conventional roughing strategies with large
lateral infeed, the feedrate is adjusted based on this reference technology and in rela-
tion to the Infeed width (ae) parameter. The chip thickness is retained.
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Type of cut parameter Calculation rule

Expected tool engagement (ae): Side allowance for
which the defined technology data is designed.

Cutting length * factor

Tool diameter * factor

Tool diameter sample table

Expected tool engagement (ap): Hub allowance for
which the defined technology data is designed.

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Steep slope feedrate factor: Reduce the machining
feedrate for plunging movements using the Steep
slope angle parameter.

Constant

Steep slope angle: Define the angle from which the
Steep slope feedrate factor parameter is applied to
the machining feedrate.

Constant

Scallop height: Theoretical scallop height that de-
fines the infeed using the Scallop height infeed
mode.

Constant

Infeed: Infeed using the Constant stepdown, Con-
stant stepover, or 3D stepover infeed mode.

Stepover formula

Tool diameter sample table

Tool diameter and corner radius sample table

Expected tool engagement (3D): 3D allowance (al-
lowance on bottom and side) for which the defined
technology data is designed.

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Feedrate/revolution: Machining feedrate per revolu-
tion.

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Retract feedrate/rev: Machining feedrate per revolu-
tion for the retract movement.

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Lateral infeed: Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Edge control: Only available in the Thread milling
type of cut. Define whether the edge control func-
tion is switched on or off.
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Type of cut parameter Calculation rule

Max. drilling depth: Define the depth to which the
tool can machine with the respective strategy.

Tool diameter * factor

Tool diameter sample table

Tool diameter and corner radius sample table

Drill size: Define the diameter with which the hole
will be pre-machined.

Tool diameter * factor

Tool diameter sample table

The following types of cut can only be used in the jobs of the same name. The parameters of the individual
types of cut reflect the parameters of the respective job.

• Simple drilling
• Drilling with chip break
• Drilling with pecking
• Centering
• Gun drilling
• Optimized deep hole drilling (with/without chip break )
• Boring
• Tapping

Calculation rules and their meaning

Calculation rule Meaning

Feedrate * factor Define the axial feedrate, for example, based on the
regular feedrate using a factor. The feedrate of the
individual tool is always taken into account.

Constant Use Constant to set a specific parameter to a con-
stant value for all tools in a tool series. The value
applies to all tools.

Tool diameter sample table Use the Tool diameter sample table to define spe-
cific values for individual diameters. The value
range between two examples is interpolated linear-
ly.

Only the range between the smallest and largest diameter is defined!
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Calculation rule Meaning

Tool diameter and corner radius sample table Use the Tool diameter and corner radius sample
table to define specific values for individual diam-
eter/corner radius combinations. The value range
between the minimum and maximum values is in-
terpolated.

Only the range between the smallest and largest values is defined!
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Calculation rule Meaning

Tool diameter and pitch sample table Only available in the Tapping type of cut. Use
the Tool diameter and pitch sample table to define
specific values for individual diameter/pitch combi-
nations. The value range between the minimum
and maximum values is interpolated.

Tool diameter * factor Based on the tool diameter, use a factor to define
the value for the F/edge parameter, for example.
The diameter of the individual tool is taken into ac-
count.

Cutting length * factor Based on the cutting length of the tool, use a fac-
tor to define the value for the Infeed length max
parameter, for example. The cutting length of the
individual tool is taken into account.

Standard material removal rate * factor The calculation rule is only available for the Stand-
ard roughing type of cut.

The F/edge for full cuts is derived on the basis
of the material removal rate during the standard
roughing cut. The feedrate can also be reduced
using a factor.

Standard adjusted speed formula The calculation rule is only available for the Tro-
choidal roughing type of cut.

Due to the reduced lateral infeed during trochoidal
roughing, the tool life increases. The cutting speed
is increased accordingly to such an extent that the
tool life is maintained in relation to the tool’s refer-
ence technology.

The Cutting speed formula calculation rule allows tool manufacturers to use their own
formulas to adjust the cutting speed.

Standard chip thinning formula Use to keep the chip section constant depending on
the lateral infeed (Ae).

The Feedrate per edge formula calculation rule allows tool manufacturers to use their
own formulas to adjust the mean chip section.

Stepover formula Use to calculate the Constant stepdown, the Con-
stant stepover, or the 3D stepover based on the
Scallop height parameter.

Cutting classes and materials
To define a new cutting class or a new concrete material, proceed as follows:

1. Click Yes to open the Materials dialog.
2. In the Materials dialog, click the icon (1) and then select the  Add cutting class material or  Add

cutting class material from material database function.
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3. As soon as a cutting class exists (1), click the button (2) (Add concrete material) to define a material
belonging to the cutting class. To change the name of the cutting class, click the required row in the
Name column. Add a comment if required.
Cutting classes can be deleted or reassigned as long as no specific materials are assigned.
The following functions are also available in the dialog.  (3) Delete concrete material.  (4) Reassign
concrete material.

Use the Reassign concrete material function to convert a legacy material from an older database to the
new material structure or to reassign a missing material (as a user-defined material).

4. Then confirm the selection with OK .

Cutting classes and specific materials cannot be changed, which means that only one
instance of the cutting class or the specific material is ever available in the database.

hyperMILL®

48



Convert legacy material to standard material / delete legacy material

1. Click the icon (4) to convert a legacy material into a standard material by selecting a required material
from the material database.

2. Click the icon (5) to delete a legacy material.
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Overview: jobs and types of cut
List of types of cut that can be used in a job. A type of cut is defined in the tool database as part of the series
definition for a tool type and depending on the material used.

Symbol Type of cut

Drilling

Centering Centering

Simple Drilling Simple drilling

Drilling with chip break Drilling with chip break

Drilling with pecking Drilling with pecking

Reaming Reaming

Tapping Tapping

Helical Drilling Helical plunge

Ramp plunge

Side semi-finishing

Side finishing

Circular Pocket Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

Optimized deep Hole Drilling (new) Optimized deep hole drilling

Optimized deep hole drilling with chip break

Boring Boring

Gun Drilling Gun drilling

Back Boring Back boring

Thread Milling Thread milling

Chamfer Milling on 3D Model Chamfer milling

2D Milling

Pocket Milling Standard roughing

Trochoidal roughing

High-feed roughing

Side semi-finishing

Side finishing
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Symbol Type of cut

Contour Milling Full cut

Standard roughing

Trochoidal roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

Contour Milling on 3D Model Full cut

Standard roughing

Trochoidal roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

Inclined Contouring Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

Inclined Pocketing

Rectangular Pocket

Standard roughing

High-feed roughing

Face semi-finishing

Face finishing

Rest Machining Full cut

Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing
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Symbol Type of cut

Face finishing

Face Milling Standard roughing

High-feed roughing

Face semi-finishing

Face finishing

Playback Milling Full cut

Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

Plunge Milling Plunge Milling

3D Milling

3D Optimized Roughing

3D Arbitrary Stock Roughing

Standard roughing

Trochoidal roughing

High-feed roughing

Face semi-finishing

Face finishing

3D Profile Finishing 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Z Level Shape Finishing Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Iso Machining 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Free Path Milling Ramp plunge

Full cut

Standard roughing

hyperMILL®

52



Symbol Type of cut

Trochoidal roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Plane Machining Standard roughing

High-feed roughing

Face semi-finishing

Face finishing

3D Z Level Finishing Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Advanced Milling

3D Plunge Roughing Plunge Milling

3D Complete Finishing 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Equidistant Finishing 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Automatic Rest Machining Standard roughing

High-feed roughing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Corner Rest Machining Standard roughing

High-feed roughing

Face semi-finishing

Face finishing
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Symbol Type of cut

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Cutting Edge Machining Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

3D Rework Machining Ramp plunge

Full cut

Standard roughing

Trochoidal roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

3D Curve Flow Machining Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

5X Cavity Milling

5X Optimized Rest Roughing Standard roughing

High-feed roughing

5X Profile Finishing

5X Radial Machining

3D semi-finishing

3D finishing

5X Z Level Finishing Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)
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Symbol Type of cut

5X Equidistant Finishing 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Rest Machining Standard roughing

High-feed roughing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Corner Rest Machining Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Free Path Machining Ramp plunge

Full cut

Standard roughing

Trochoidal roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Rework Machining Ramp plunge

Full cut

Standard roughing

Trochoidal roughing

High-feed roughing

Face semi-finishing

Face finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)
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Symbol Type of cut

5X Z Level Roughing Standard roughing

High-feed roughing

5X Cutting Edge Plunge Plunge Milling

5X Cutting Edge Swarf Standard roughing

Trochoidal roughing

Face semi-finishing

Face finishing

5X Halfpipe Machining 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Surface Milling

5X Top Milling

5X Iso Top Milling

Standard roughing

High-feed roughing

Face semi-finishing

Face finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Contouring Full cut

Standard roughing

Trochoidal roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Swarf Cutting one Curve

5X Swarf Cutting two Curves

5X Swarf Cutting Planes

Full cut

Standard roughing

Trochoidal roughing

Side semi-finishing

Side finishing

Face semi-finishing
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Symbol Type of cut

Face finishing

5X Shape Offset Roughing Standard roughing

Trochoidal roughing

High-feed roughing

Face semi-finishing

Face finishing

5X Shape Offset Finishing Standard roughing

High-feed roughing

Side semi-finishing

Side finishing

Face semi-finishing

Face finishing

5X Tangent Machining

5X Tangent Plane Machining

Side semi-finishing

Side finishing

5X Prismatic Fillet Finishing 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Tube Milling

5X Tube Roughing Standard roughing

High-feed roughing

5X Tube Finishing

5X Tube Rest Machining

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Blade Milling

3D Blade Roughing Standard roughing

High-feed roughing

5X Blade Point Milling 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Blade Platform Machining Side semi-finishing

Side finishing

3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)

5X Blade Top Milling 3D semi-finishing (fine – medium – rough)

3D finishing (fine – medium – rough)
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Symbol Type of cut

5X Blade Tangent Milling Side semi-finishing

Side finishing

Define coupling

CHANGED USER GUIDANCE
Since version 2024, the coupling types Weldon, Weldon shank and Shrink fit became
standard types and can be directly used in the coupling area of the component (Tool,
Extension, Holder, Tool holder). For tools the Diameter of the top coupling is automatically
adapted to the tool diameter or shank when present. Tools using former coupling classes
are automatically converted.  

VIRTUAL Machining Center
Program run (simulation)

SIMULATION REQUIREMENTS
The following requirements must be met to be able to perform a program run (simulation):

• A component (Model) must be defined for milling and drilling operations, see hy-
perMILL® → Job list → Model → Model.

• A component (Model) and a 2D turning contour must be defined for turning operations,
see hyperMILL® → Job list → Model → Turning model.

If this is not the case, the VIRTUAL Machining Center cannot be started. A corresponding
message is displayed.

Controlling visibility in the graphics area

Turning operations
For turning operations, the stock, component, and fixture are shown rotated. Prerequisite for the rotated
display of the stock: The material removal simulation is activated.

21
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(1) Display of fixture, component, and stock for milling and drilling operations. (2) Display of fixture, compo-
nent, and stock as rotational geometry for turning operations.

Simulating the VNC or NC program file
Run a collision check

After starting the collision check, the progress indicator in the simulation control panel changes
as follows:

1  Progress of the collision check in the loaded program file. Either a collision, component violation, or a
contact was detected.

2  Progress of the collision check in the loaded program file. No collision, component violation, or contact has
yet been detected.

3  The collision check ended without a collision, component violation, or contact.
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4  The collision check ended with a contact. Detailed information on this can be found in the output message
and in the upper window of the display area.

5  The collision check ended with either a collision or component violation. Detailed information on this can
be found in the output message and in the upper window of the display area.

6  Machine position in the loaded program file.

Collision check and material removal

Move the machine to the next warning. The button turns yellow if a warning (for example,
violation of the axis limit) has occurred.

Move the machine to the next warning or next error. The button turns red if an error or an error
and a warning have occurred.

Move the machine to the next collision area. The button turns yellow after the collision check
has been carried out if a contact has been detected.

Move the machine to the next collision area. The button turns red after the collision check has
been carried out on detecting the following:

• A collision or a component violation
• A collision and a component violation
• A collision and a contact
• A component violation and a contact
• A collision, a component violation, and a contact

.

Configuration

Turret setup: Only available if the VIRTUAL Machining Center has been started in Machining
planner mode and in hyperMILL® (Job list → Postprocessor), a corresponding Virtual Machine
has been loaded.

Equip a turret with static holders and NC tools for turning operations.

TOOL Builder
Introduction

Many tool suppliers offer 3D models of their tools. You can use the TOOL Builder to interactively prepare
these models so they can be used for calculation, collision checking and simulation.

The following tools and tool elements are supported:

7  Static holder (turning with turret)
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1

2 3

4

A B C

5 6

7

By default, tools are assigned the name of the document with which they were created.

CAD entities, which are used to define a tool holder, holder, static holder or extension, are
locked against further editing.

Steps for creating
Turning tool: Creating a static holder for machining with a turret

Import the 3D data provided by tool manufacturers and create a static holder for turning operations with a
turret.

To create a static holder for machining with a turret with the TOOL Builder, proceed as follows:

In the tool database, on the Static holders → New → Turret holder → Geometry dialog page, click
the icon to start the TOOL Builder.

Then use the File → Open dialog to open a 3D geometry file in *.step,*.stp,*.iges, or
*.hmc format.

Define the body
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Define the geometry of the static
holder.

The geometry of the holder is au-
tomatically detected, so that after
opening the file, the Elements of
the body are already selected and
highlighted in color.

The number of elements is dis-
played.

Y

Z

X

Define the holder axis

To do this, Select the required ele-
ments (for example, the reference
coordinate system 1 ).

Alternatively, select 2 Points. The
order of selection defines the direc-
tion of the axis.

If necessary, invert the direction by
double-clicking the arrow of the ax-
is or activate the Invert function.

The program attempts to automat-
ically detect the Machine side 2 .
Correct the machine side if neces-
sary.

Z

X Y

2

1

Define the holder coupling

To do this, select a Face or a
Point.

The selected element 1  is high-
lighted in color. Specify the X di-
rection of the reference coordinate
system. To do this, select the X ax-
is of the reference coordinate sys-
tem, 2 Points, or one Point.

Machine side 2 , Clamping side
3 , and Workpiece side 4  are dis-

played.

1

2

3

4

Y

Z

X

Click the button to rotate the X axis
direction by 90°.
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Define the tool axis

To do this, Select the required ele-
ments 1 .

Alternatively, select 2 Points.

The order of selection defines the
direction of the axis.

Invert the Direction by double-click-
ing the axis arrow or activate the
Invert function.

Clamping side 2  and Workpiece
side 3  are displayed.

Y

Z

X

3

1

2

Define the tool coupling

Select a Face 1  or a Point to de-
fine the area of the tool coupling.

If necessary, manually adjust the X
direction of the axis. To do this, Se-
lect the required elements. Alterna-
tively, select 2 Points or one Point.

The order in which the points are
selected defines the direction of
the axis.

Machine side 2 , Clamping side
3 , and Workpiece side 4  are dis-

played.

1

2

3

4
Y

Z
X

Click the button to rotate the X axis
direction by 90°.

Export the data

Transfer the imported 3D file with the previously defined elements to the tool database as a
static holder.

CAD
Introduction
Documentation and help
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Send to support

Send the current document to support.

Help → Send to support 2024

Save the currently open document as a hyperMILL® SHOP Viewer document and send it as an e-mail
attachment to your OPEN MIND support contact. The computer’s e-mail client is started. Explain the issue.
Enter the e-mail address of your OPEN MIND support contact under To as the recipient.

User interface

Tabs

Model

Assign entities to current layer
Assign selected entities to the current layer. To do this, select the Assign entities to current layer command
on the context menu.

Default settings
Options / properties

Load and locally modify the defaults for the model, the model structure and the graphical attrib-
utes of the document and the software.

File → Options → Options / properties

Graphic > System > Navigation
3D input device: In order to remain compatible with older products from the manufacturer 3Dconnexion, we
recommend selecting the previous driver (Legacy option). Select the 3DxWare SDK4 option to support the
current functionality.

Sketcher options

Options for the Sketch and V-sketch commands

File → Options → Sketcher options

V-sketch options
Strict chirality: If the option is not selected, the point-arc constraint (or the point-line constraint) can slide
beyond the imaginary extension of the entity (line and circle). If the option is selected, it does not slide, but
remains limited to the existing part of the arc or line.

Data interfaces
OPEN MIND Software

Import and save different OPEN MIND data.

hyperMILL®

64



Own file formats

*.bnd Table 1. Options for opening a *.bnd file

Property Description

General Entity precision: Enter a value that is used for the same-named Entity precision
property of the CAD entities.

Unit of measure: Read in data in the Millimeter unit of measure or Inch unit of
measure. Select the unit of measure.

*.omx Table 2. Options for opening an *.omx file

Property Description

General Entity precision: Enter a value that is used for the same-named Entity precision
property of the CAD entities.

Unit of measure: Read in data in the Millimeter unit of measure or Inch unit of
measure. Select the unit of measure.

Import PMI with MBD
For MBD 1 from STEP AP242, SOLIDWORKS, Siemens NX, CATIA V5, and PTC Creo, dimensions, surface
finishes, and tolerances are imported, automatically evaluated by the software, and linked to faces and their
measurements. Tags are assigned for this purpose.

Example 1. MBD tags (selection)

T_PMI_DIM_TOL_FORMAT

T_PMI_DIM_TOL_NUM_LOW ER

T_PMI_DIM_TOL_NUM_UPPER

T_PMI_DIM_TYPE

T_PMI_DIM_VALUE

These can be viewed using the Tags → Edit info command, for example.

In the T_PMI_DIM_REFERENCES tag, the name of the referenced dimension, such as a length dimension, is
used to create a link to the dimensioned faces. The names of the entities in the T_NAME tag must be unique.

In the settings for importing CAD data, enable the Convert hidden entities option under Entity conversion
modes.

When creating the dimensions in the upstream CAD software, make sure that the dimensions are generated
with reference to faces and not to face edges. When referencing edges, the faces cannot be clearly assigned.
No subsequent manual adjustment of dimensions may be made. Tolerance values and tolerance classes
must match.

Shape and position tolerances are imported as dimensions and can be visually evaluated
by the user.

1Model Based Definition 
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Analysis
Attributes

Local curvature

Get information about local curvature attributes of a face or a curve.

Analysis → Local curvature

Configuration

• For face and curve on face:
• A point on an entity, the direction of the normal, and the UV directions can be generated individually as

required.
• For individual curve:

• A point on an entity, the direction of the normal, and the UV directions can be generated individually as
required.

Edit and modify
Edit

Copy

Copy to clipboard.

Edit → Copy

Control the behavior for copying
The settings from the copy_defaults.xml file are used when copying entities from document to document
via the clipboard.

The file with the general preferences is in C:\Program Files\OPEN MIND\hyperCAD-S\[ver-
sion]\files\factorysettings. For individual presets copy this file in the folder C:\Users\[USER]
\AppData\Roaming\OPEN MIND\hyperCAD-S\[version]\commands\defaults. If the folder does
not exist, create the folder. Customize the settings in the copied file.

The file copy_defaults.xml has the following structure:

<?xml version="1.0"?>
<PBag name="filecmd.Copy"
      version="1">
    <property name="SaveAllMaterials"
              type="omslLong"
              uuid="40dff002-f0e9-59f9-b8a8-04776d96aea9"
              dimension="Dimensionless">1</property>
    <property name="SaveMating"
              type="omslLong"
              uuid="40dff002-f0e9-59f9-b8a8-04776d96aea9"
              dimension="Dimensionless">0</property>
    <property name="SaveSpreadsheet"
              type="omslLong"
              uuid="40dff002-f0e9-59f9-b8a8-04776d96aea9"
              dimension="Dimensionless">0</property>
    <property name="UseCurrentWP"
              type="omslLong"
              uuid="40dff002-f0e9-59f9-b8a8-04776d96aea9"
              dimension="Dimensionless">1</property>
</PBag>
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Attribute Elements or property Configuration possibilities

SaveAllMaterials Copy material. 0: Do not copy

1: CopySaveMating Copy mating

SaveSpreadsheet Copy variables.

UseCurrentWP Copy current workplane

The attributes uuid contained in the XML structure are the same everywhere. Every user can use the file.

If, for example, mating properties or spreadsheet variables are required, the corresponding options must be
enabled in the files copy_defaults.xml and paste_defaults.xml.

Align dimensions

Align multiple dimensions to reference.

Edit → Align dimensions 2024

Align multiple dimensions to reference. The cursor changes. First select the reference dimension to align
to  1 . Then select the dimensions to be aligned 2 . If the dimension to be selected is not permitted due to the
direction, feedback about an incorrect selection is displayed.

44

40

12 4440 12

1

2
2

Stretch 2D

Stretch two-dimensional contour curves.

Edit → Stretch 2D 2024

Stretch two-dimensional contour curves. Stretch a turning contour to adjust it to the center of the tolerance.

It is advisable to adjust the turning contours with this command. Use this adapted contour
as a 2D model for the turning jobs that is also transferred to the SIMULATION Center and
included in the collision check.

Select
Entities: Select curves  1 . The number of selected entities is displayed.
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X

1

2

Movement
Movement is limited to the XY plane. Entities can also be moved using the manipulator. When the handles of
the manipulator are moved in the graphics area, the values in the dialogue are updated. If you click an axis,
the cursor jumps to the associated input.

Start: Select start point  2 .

End: Select end point  3 .

Delta: Enter or check the linear translation in the X and Y direction.

3 3 3

More options
Keep original: Specify whether the selected entities should be retained.

Keep attributes: Color attributes are retained.

Control the dependencies to the adjacent curves:

Side lines: Select whether to stretch the existing, adjacent curves A , or whether to insert new side lines for
stretching  B .

Keep angles: Specify whether you want the angles of the adjacent curves to remain constant  C .

A B C
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Modify

Invert curves

Invert the orientation of curves.

Modify → Invert curves

Select
The direction arrows can be optionally used to select the curves to which they refer.

When zooming out of the view, the size of the arrows remains constant. This can make
it easier to select the arrows of the required direction, for example, by making a selection
with Window or Lasso.

Points, curves and faces
Drafting

Round / chamfer 2D corners

Use criteria to find all required corners of a contour and round or chamfer them.

Drafting → Turning → Round / chamfer 2D corners 2024

Use criteria to find all required corners of a contour and round or chamfer them. Distinguish between inner
and outer corners. Corners can optionally be left out.

Select

Curves: Select entities  1 . The number of selected entities is displayed.

X
1

Concave corners
Inner corners  3  are highlighted in color and can be adjusted.

Found: The number of inner corners found is displayed.

Show: Switch the highlighting of the corners found on or off.

Mode: Use Keep to not change the corner  4 5 , Fillet to insert a fillet  7 , or Chamfer to chamfer the corner  6 .

Fillet radius: Enter a value  9 .

Chamfer distance: Enter a value  8 .
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3 7

4

9

Convex corners
Outer corners  2  are highlighted in color and can be adjusted.

Found: The number of outer corners found is displayed.

Show: Switch the highlighting of the corners found on or off.

Mode: Use Keep to not change the corner  4 5 , Fillet to insert a fillet  7 , or Chamfer to chamfer the corner  6 .

Fillet radius: Enter a value  9 .

Chamfer distance: Enter a value  8 .

2

5

6
8

Skip corners
Select: Select the corners to be ignored 10 . The number of selected corners is displayed. The omitted corners
are highlighted in color.

3

10

4
7

More options
Min. corner angle: Enter the minimum angle between the two curves forming the corner up to which the
corner should be recognized as such.

Total corners found: The total number of corners found is displayed.

Associative: The fillets and chamfers are linked to the adjacent curve entities. When these entities are
changed, the linked entities are also updated.

Automatic trim: Trim the contour automatically after inserting fillets and chamfers.
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Reset 2D corners

Reset undercuts, fillets, and chamfers on sharp-edged corners.

Drafting → Turning → Reset 2D corners 2024

Reset undercuts, fillets, and chamfers on sharp-edged corners as required.

Select
Curves: Select entities  1 . The number of selected entities is displayed.

X

1

2

Fillets
Geometric recognition: Recognize fillets based on the geometry.

Max. radius: Specify the radius up to which a curve is to be interpreted as a fillet. Enter a value.

Chamfers
Geometric recognition: Recognize chamfers based on the geometry.

Max. diagonal length: Specify the diagonal length up to which a curve is to be interpreted as a chamfer. Enter
a value.

Angular tolerance: Enter an angle value indicating by how much the chamfer may deviate from 45° in order to
still be considered a 45° chamfer.

Undercuts
By tag recognition: Undercuts are marked with a tag when they are inserted using the 2D undercut [71]
command. This tag is used to recognize undercuts.

Skip corners
Select: Select the fillets, chamfers, and undercuts to be ignored 2 . The number of selected fillets, chamfers,
and undercuts is displayed and highlighted in color.

More options
Total corners found: The total number of corners found is displayed.

Show: Fillets, chamfers, and undercuts are highlighted in color.

2D undercut

Insert predefined 2D undercuts.

Drafting → Turning → 2D undercut 2024

Insert undercuts for local rewinds into a 2D contour for turning in a form standardized according to DIN 509.
The inserted undercut curves are marked with a T_UNDERCUT2D_TYPE tag.

Select
Curves: Select the two curves at right angles to each other of a corner where an undercut is to be inserted 1 .
The number of selected entities is displayed.
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X
1 2 3

Select undercut

Shape: Select the shape of the undercut based on the standard offered (E, F, G, H)  2 .

Configuration: The software automatically suggests a size range if the workplane is set for turning the 2D
contour. The X axis of the workplane must lie in the rotational axis of the contour. Optionally change the size
range.

More options
Automatic trim: Trim the contour automatically after inserting undercuts  3 .

Associative group: The curves of the undercut are grouped. The group is given the shape and the selected
configuration of the standard as its name. When these entities are changed, the linked entities are also
updated.

Trim 2D corners

Trim 2D corners.

Drafting → Turning → Trim 2D corners 2024

Trim 2D corners in relation to existing, previously added fillets, chamfers, and undercuts for turning that were
not trimmed automatically.

Select
Curves: Select entities  1 . The number of selected entities is displayed.

X

1

Shapes

Sweep (two contours)

Generate side faces between two contours.

Shapes → Sweep (two contours) 2024

Generate side faces between two contours with the same number of segments, optionally for planar contours
with top and bottom faces and as a solid.
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First contour
Curves: Select entities. The number of selected entities is displayed. All selected entities must complement
each other to form a closed contour.

Second contour
Curves: Select entities. The number of selected entities is displayed. All selected entities must complement
each other to form a closed contour.

Synchronization points
Relate a point or a position on the first contour to a point or a position on the second contour to avoid
unwanted twisting. The software suggests a solution. A maximum of one synchronization point per contour is
possible.

First: Select point or snap position.

Second: Select point or snap position.

3
1

2

More options
Invert: Correct the orientation of the contours if the faces intersect incorrectly in the preview.

Invert normals: The direction of the face normals of the generated faces is reversed.

With bases: A top face and a bottom face are created if the selected curves and face boundaries result in a
closed contour line and are flat.

Solid: Collect the faces into a solid.

4 5

From grid

Create a face from several curve chains in one direction plus several curve chains in
the other direction.

Shapes → From grid 2024

Create a face from several curve chains in one direction plus several curve chains in the other direction A .
The number of curves per chain can vary. The curve chains in both directions must intersect within a given
tolerance. If curve chains protrude, the last intersection point is used for the edge boundary. The resulting
protruding curve segments are not included in the face. The face can be created closed in one direction B .
Both directions can converge at the start or end of the face, or the face can just consist of three edge
boundaries  C .
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A B C

Click the message line for the “Intersections missing” message on the Info tab to display the positions where
this situation occurs.

Click the message line for the “Most distant points” message on the Info tab to display the positions where
this situation occurs.

First direction
Curves: Select curves in the first direction  1 . The number of selected entities is displayed.

Second direction
Curves: Select curves in the second direction 2 . If all curves in the first direction have already been selected,
the curves in the second direction can also be selected via the curves in the first direction, for example,
using a window selection. The curves in the first direction are not automatically used as curves in the second
direction. The number of selected entities is displayed.

1
2

Continuity
It is possible to control the continuity of the transition to an existing face 3 . To do this, select the boundary of
the existing face and no curve at this position 4 . Select whether the continuity between the existing face and
the face to be created should only be maintained with regard to Position G0 or also with regard to Tangency
G1.

3

4

Intersecting curves
Tolerance: Enter a value for the maximum permissible distance at which curves should still be tolerated as
intersecting.
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Precision
Distance of the furthest point: Outputs the furthest distance between the face to be generated and the curve
chains.

Parametric modeling
Automatic rebuild on / off

Switch automatic rebuild on and off after a change in the parametric design.

Edit → Parametric → Automatic rebuild on / off

Solids

2024

Control automatic rebuild after changes in the parametric design as required. For example, you can make
several changes in a sequence and only then update the parametric design. While rebuilding is interrupted,
most commands are grayed out. The changed values of the dimensions or dependencies are indicated by the
symbols < and >. A single Undo/Redo step is created for the entire interruption.

Add the command to the toolbar in the graphics area. To do this, use the File → Options →
Toolbars and tabs command.

Solids, features and meshes
Features

Protrusion (two contours)

Create a protrusion between two contours that define the shape of the protrusion.

Features → Protrusion (two contours)

Solids

2024

Create a protrusion between two contours with the same number of segments that define the shape of the
protrusion.

First contour
Curves: Select entities 1 . The number of selected entities is displayed. All selected entities must comple-
ment each other to form a closed contour.

Second contour
Curves: Select entities 2 . The number of selected entities is displayed. All selected entities must comple-
ment each other to form a closed contour.

Face: Select a face of the existing solid in which to embed the protrusion to be generated  3 .

1

3
2

4
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Synchronization points
Relate a point or a position on the first contour to a point or a position on the second contour to avoid
unwanted twisting  4 . The software suggests a solution. A maximum of one synchronization point per contour
is possible.

First: Select point or snap position.

Second: Select point or snap position.

More options
Invert: Correct the orientation of the contours if the side walls of the protrusion intersect incorrectly in the
preview.

Invert normals: The direction of the face normals of the generated faces is reversed.

Slot (two contours)

Create a slot between two contours that define the shape of the slot.

Features → Slot (two contours)

Solids

2024

Create a slot between two contours with the same number of segments that define the shape of the slot.

First contour
Curves: Select entities 1 . The number of selected entities is displayed. All selected entities must comple-
ment each other to form a closed contour.

Second contour
Curves: Select entities 2 . The number of selected entities is displayed. All selected entities must comple-
ment each other to form a closed contour.

Face: Select a face of the existing solid in which to embed the slot to be generated  3 .

Synchronization points
Relate a point or a position on the first contour to a point or a position on the second contour to avoid
unwanted twisting  4 . The software suggests a solution. A maximum of one synchronization point per contour
is possible.

First: Select point or snap position.

Second: Select point or snap position.

1

3
2

4

More options
Invert: Correct the orientation of the contours if the side walls of the slot intersect incorrectly in the preview.

Invert normals: The direction of the face normals of the generated faces is reversed.
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Solid

Repair open solid

Repair open solid.

Modify → Repair open solid

Solids

Cover openings
Create capping: Cover openings caused by removed hole geometries and other openings in the solid.
Openings that touch several faces are covered. Planar and non-planar openings are covered. The capping is
created as a separate open solid.

Meshes

Mesh from faces

Creates meshes from faces and faces in solids.

Shapes → Mesh from faces

Solids

More options
Create single mesh: Create a single mesh from all selected faces.

Keep original: Specify whether the selected entities should be retained.

Keep attributes: Color attributes are retained.

Design electrodes

Imported CAD geometry data often does not have the quality required to create an electrode. Despite
undercut and missing faces, gaps between faces, and overlapping faces, the software allows electrodes to
be created on the basis of such CAD geometry data. A warning is only issued if the electrode geometry does
not specify a closed shape. It is up to the user to assess whether such a situation will have a negative impact
on the generation, NC programming, and production of the electrode, and whether it needs to be corrected in
advance.

Electrode options

Select default settings for electrodes.

File → Options → Electrode options

Electrode

Geometry

Prepare
Closing holes from single faces: Features such as holes and breakthroughs inside a Domain (with a single
continuous face boundary) can be closed automatically. Switch off the option for eroding lettering, for exam-
ple.

hyperMILL®

77



Technology

• Generator program: Select the required generator program. Displays all generator programs that are
entered in the XML file for generator programs selected in the XML file for generator program option. Also
see Preparing generator programs [80].

Folders
XML file for generator program: Select an electrode_generator_programs.xml file with generator
programs for performance parameters for eroding. Also see Preparing generator programs [80].

Create partial

Create electrode geometries without an electrode block and electrode holder.

Electrode → Create partial

Electrode

More options
Closing holes from single faces: Features such as holes and breakthroughs inside a Domain (with a single
continuous face boundary) can be closed automatically. Switch off the option for eroding lettering, for exam-
ple.

Create user defined

Extend existing electrode geometry to create a complete electrode.

Electrodes → Create user defined

Electrode

Mode
Default: Create an electrode with extensions.

Simplified: Create an electrode without extensions. The selected faces of the electrode shape are transferred
to the electrode without any adjustments or additions. It is not necessary to repair the CAD geometry
beforehand. Enter a minimum distance between electrode and block with the Distance value.

Faces for a user-defined electrode (Electrode shape → Shape) must not have been previ-
ously selected as entities in Create reference system. This would lead to a collision check
taking place within itself.

Modify eroding path

Make eroding path visible and modify.

Electrodes → Modify eroding path

EDMconNG

2022.1

Blind

Motion
In addition to lines, arcs can also be selected as eroding paths. The curves can run three-dimensionally in
space and do not have to lie in XY planes parallel to the EDM reference. The eroding path is broken down
into individual waypoints.

Through
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Motion
In addition to lines, arcs can also be selected as eroding paths. The curves can run three-dimensionally in
space and do not have to lie in XY planes parallel to the EDM reference. The eroding path is broken down
into individual waypoints.

Using user-defined tags for electrode documentation
Create your own user-defined tags for additional information, add values, and use them in the title block of
electrode documentation.

For electrode assembly

Preparation in the title block template

1. In the hyperCAD-S\files\printingtitleblocks folder, switch to the folder of the language set for
the software.

2. Open the assembly_electrode_tb.hmc file.
3. Create a tag with Tags → Create → Quantified tag.
4. Determine the position within the title block and insert a link to the tag in Drafting → Text.
5. Select the new tag on the Tags tab and select the Assign command on the context menu. Select the text

there and apply the entries.
6. Save the file.

In the electrode document

1. New tags that have been added to assembly_electrode_tb.hmc are shown at the end of the list in
the Electrodes → Print and Electrodes → Modify EDM parameters commands when the Document option
is selected.

2. Change the content of the tags.
3. Generate the required electrode documentation.

For single electrode

Preparation in the title block template

1. In the hyperCAD-S\files\printingtitleblocks folder, switch to the folder of the language set for
the software.

2. Open the single_electrode_tb.hmc file for a new user-defined tag for a single electrode.
3. Create a tag with Tags → Create → Quantified tag.
4. Determine the position within the title block and insert a link to the tag in Drafting → Text.
5. Select the new tag on the Tags tab and select the Assign command on the context menu. Select the text

there and apply the entries.
6. Save the file.

In the electrode document

1. Use the Tags → Create → Quantified tag command to generate a tag with identical tag names.
2. Assign this tag to the required electrode – as a whole, that is, to the electrode group in the model.
3. Use the Tags → Edit info command to change the content of the tag.
4. Generate the required electrode documentation.

Export to EDM

Convert electrodes into readable EDM files.

Electrodes → Export to EDM

EDMconNG

2024

Convert electrodes into readable EDM files.

Reports for the following eroding machine types can currently be converted.
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Manufacturer Software Ver-
sion

Output 3-point
path

Virtual electrode Rotating elec-
trode

Output 3D
path

Zimmer & Keim Alphamoduli x x x x

OPS Ingersoll Multiprog x x x

ONA x x x

+GF+HMI AC FORM HMI x x x

Exeron Exoprog x x x

EDM export
Select the eroding machine with the relevant software version from the drop-down list.

EDM file name
Enter a file name without a file extension.

Electrode list
Only selected: Optionally perform an export with selected electrodes only. To do so, select the option. Select
the relevant electrodes with the left mouse button. Otherwise, all listed electrodes will be included in the
export. The list is sorted by name.

Preparing generator programs
Manage erosion performance parameters using generator programs instead of individual erosion technology
settings. For example, transfer existing generator programs from the eroding machine. Write the optional text
information for the software to the Name attribute. Insert information for easier management of the generator
programs in the description attribute:

<?xml version="1.0"?>
<GeneratorPrograms>
    <program name="VDI33GAP15VDI41GAP10" description="EDM_example1" />
    <program name="VDI24GAP10VDI18GAP08" description="EDM_example2" />
</GeneratorPrograms>

The generator programs are offered for selection on the Electrodes menu in the commands Create, Create
user defined and in Modify EDM Parameters as well as in the Electrode options. For this purpose, insert this
file into Electrode options → Folders → XML file for generator program. The location and name of this file are
freely selectable.

CAM programming
Overview

Toolpath properties

Analyze toolpaths.

CAM → Toolpath properties

Configuration

Toolpath settings → Data filter
The following options appear in the user interface depending on the type of job – if the data is available.

Show tool reference: Select the tool reference point to which the display of the toolpath with ball mill or
lollipop cutter should refer.

The globally set color for toolpaths NC path GO and NC path G1 from the hyperMILL settings is used to
display additional toolpath profiles.
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• Tip only
• Center only
• From Job
• Both variants

Rest material display

Display remaining rest material for visual analysis.

CAM browser → Jobs → Shortcut menu → Utilities → Rest material display 2024

Display remaining rest material for visual analysis. A comparison of the pre-calculated current machining
status with a workpiece is carried out and the differences are displayed. A current stock chain is required for
this.

Color/rest material thickness
Color: Double-click with the left mouse button on the color field in the table to open the dialog for changing
the color of the interval.

Rest material thickness: Double-click with the left mouse button on a table row to change a value of the
interval limit.

Limits
Minimum rest material that is taken into account in the rest material display. Maximum rest material that is
taken into account in the rest material display. Enter Min. and Max..

Example: Default values for color and rest material thickness

1

5

32

4

1

5

3
2

4

Tolerance
Model geometry: Value for the accuracy of the rest material display.

Update: Update the display of the rest material.

More options
Number of intervals: The rest material is displayed in five intervals. A higher value increases the fineness of
the display.

Exact computation: Refine the calculation of the rest material display. The calculation is performed automati-
cally in relation to the size of the workpiece.
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Optimal barrel cutter

Optimize parameters of barrel cutters based on surface and curve information.

CAM → Optimal barrel cutter

CAM browser → Jobs → Job → Tool: Select a barrel cutter. A function for optimizing
the barrel cutter is displayed in the tool definition. 2024

For machining with barrel cutters, the optimal shape of the barrel cutter must first be found. This ensures that
the surface to be machined is completely machined as required. The parameters of the required barrel cutter
are optimized on the basis of surface and curve information. A surface and several curves in relation to this
surface are included in the analysis. Preset values for the dimensions of the barrel cutter are taken from the
tool definition in hyperMILL® when called.

Select
Surface: Select the surface for which an optimal barrel cutter geometry is to be found for machining.

Curve: Select one or more curves in relation to this surface that represent the planned machining path. The
number of selected elements is displayed.

Barrel
When calling the dialog from the hyperMILL® job definition (Tool dialog page) and selecting a barrel cutter,
the Cutter parameters of the selected tool are adopted. The parameters can then be changed manually.

For Base diameter range and Barrel radius range, enter the minimum and maximum values between which
the optimal value is to be calculated. All other parameters are considered fixed when the calculation is
running.

Both the variables and the fixed parameters are included in the calculation of the optimal barrel radius and
base diameter.

If the dialog is started via the CAM → Optimal barrel cutter menu, preselect an option for a
conical, tangential or general barrel cutter for Barrel type and an option (ball, radius, sharp)
for Tip type.

   If the dialog is started via the hyperMILL® job definition (Tool dialog page), these
parameters are already preset and can no longer be changed.

Options
Contact parameter: Enter how the preview of the tool contact point of the barrel cutter should be positioned
in relation to the selected curve. For example, if the value 0.5 is entered, the tool preview is displayed at the
center of the curve.

Create 3D: Create a 3D model of the calculated tool geometry in the graphics area.

Verification

• Single curve: Select an individual curve to specify where the tool preview should be displayed. Enter a
value or vary it using the slider. The determined tool geometry is moved along the curve

• Use Face offset to enter a value that enlarges the internal tool shape to allow a preview of the contact area
between the tool and the surface. The smaller the value, the smaller the preview.

Further options
Cutting side: Change the tool position in relation to the surface normal of the selected surface (inside or
outside).

Infeed direction: Reverse the infeed direction of the tool in relation to the orientation of the selected curve.
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Automatic computation: The optimal tool geometry is displayed as a preview for the set values and only in the
slider position that defines the contact parameter.

Global mode: If Global mode is selected for the calculation, every point in the selected curves is taken into
account so that the optimal tool shape is calculated within all selected curves. Depending on the geometry,
the calculation may take some time. Otherwise, or if the slider is moved, the calculation is performed continu-
ously for each point currently reached. When the slider stops, the result is updated. Different tool dimensions
are obtained for the various points analyzed on the curves.

Result
Optimal barrel radius: The determined maximum possible barrel radius that fits the area is output.

Optimal barrel diameter: The determined maximum base diameter (shaft side) that fits the surface is output.

The function does not carry out a collision check! This is performed in the cycle. The
optimum shape is determined using an analytical calculation on the selected surface,
taking into account a safe tolerance, in order to obtain the best possible shape.

Current restriction: Currently, the tool is always considered normal to the curve during the
calculation. A lead angle is expected to be introduced with one of the next versions.

Adaptive construction

Close holes

Close openings within faces.

Shapes → Close holes

The openings for which a calculation has failed are displayed by clicking the message on the Info tab.

Advanced
Max. perimeter length: Maximum length of the circumference of an opening that is still to be closed.

Detect and close multi-faces holes: Detect and close cross-face openings between faces. The selection
should be targeted.

Analyzing probing results
Read in and analyze one or more measuring logs for probing jobs. Check the deviations based on the
workpiece geometry in the graphics area, in tabular form, and as a trend. The deviation, that is, the actual
state, is always determined in the face normal direction of the probing point on the face (target state). In the
graphics area, the target and actual states are displayed visually using colored dots with the deviation values.
On the Probing tab, sort and filter the results by probing job, probing data, and trends. All values are output
in relation to the current workplane. Click a probing point in the graphics area to jump to this point on the
Probing tab.

The probing results are also displayed if they are covered by other entities. In this case, the measure lines
appear dotted and the positions are shown as asterisks instead of circles. The points can always be selected,
even if they are obscured by a face, while the label with the measured values can be selected if the selection
filter does not include the face.
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The prerequisite is that the option Create logs for CAD import is enabled in Settings under
Probing when creating a job list for probing jobs in the hyperMILL® job browser.

The Create logs for CAD import command is executed via the VIRTUAL Machining Center.
The prerequisite for this is a corresponding virtual machine that is activated in the Job list
→ Postprocessor → Machine → Machine administration dialog and is available for various
machine controls.

The permissible tolerances are entered in the CAM browser when the probing job is
created.

The touch probe must be calibrated.

Interaction with other commands
Probing data can be selected for other commands.

If a command such as Deform entities or Deformation is active and the start and target points are selected
there, you can left-click the table header of the Nominal and Measured columns to select all probing point
coordinates.

The same procedure is possible if the probing points outside the tolerance are to be transferred for a probing
job. To do this, only display the probing points outside the tolerance. In the probing job, on the Contours tab,
during Contour selection, click the table header of the Nominal column. Alternatively, you can also select the
relevant table cells.

Probing tab
Read in and analyze one or more measuring logs for probing jobs. A lower and an upper deviation is possible
for each probing job. All probing points do not appear in the CAD model structure or on layers, and cannot be
influenced or filtered by the visibility filter.

Table 3. Filter or delete the probing data using the following commands:

Icon Commands Explanation

Drop-down menu On the drop-down menu, select whether all or which of the
imported files should be displayed.

Show labels Display labels with the measured values in the graphics area.
Switch the display on and off.

Nominal values Display the target states. Switch the display on and off.

Actual values – in tolerance Display the probing data within the tolerance. Switch the dis-
play of the probed points on and off.

Actual values – out of toler-
ance

Display the probing data outside the tolerance. Switch the dis-
play of the probed points on and off.

Slider with

two value input fields

Restrict the range of the displayed probing data from below
and above. To do this, enter values or move the left or right
bar by holding down the left mouse button. Change the restric-
ted area as a whole by moving it with the left mouse button
pressed. To do this, click the horizontal bar with the left mouse
button and move the mouse.

Remove all probing data.

The tab has three sections:
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Probing jobs
Probing jobs for a workpiece or a series of workpieces with one or more measuring logs are displayed in a
tree structure, sorted by probing point and imported measuring logs. The structure from the programming of
the probing jobs is used and therefore corresponds to the probing jobs created in the CAM browser whose
probing results have been read in.

The information in the tree structure is arranged like a table. The Name column contains the tree structure
itself with the name of the job list, the names of the probing jobs, and the time at which the respective
measuring log was created. The Status column summarizes whether the probing data of the substructure is
within or outside the required tolerance. This status is displayed as text and graphically:

Deviation within tolerance

Deviation outside tolerance

The Tolerance column contains the values defined for the lower and upper deviation when the probing job
was created. Further information may be displayed in the Description column.

On the context menu

• Import probing data: Select a file with probing results. Existing, previously read-in probing results are
retained.

• Open probing job: Open probing job. The command only appears if the job linked to the probing data exists
in the CAM browser of the open document.
Double-clicking with the left mouse button on the probing point to be examined also opens the probing job.

• Zoom: Zoom the graphic section so that the selected probing job or the selected probing points are
displayed centered in the graphics area.

• Activate only this: Display the selected probing job in the graphics area, but do not display all others.
• Activate all except this: Do not display the selected probing job in the graphics area.
• Expand all: Fully expand the tree structure.
• Delete: Delete selected entry.

Probing data
Displays the results from the measuring log of a probing series for a probing job in tabular form. For this
purpose, select a specific probing series in the tree structure based on the time displayed.

For each probing point (Name column), the target state from the geometry (Nominal column), the measured
actual state of the workpiece (Measured column), and the calculated value of the deviation (Deviation col-
umn) are displayed in the table. The deviation is checked to see whether it is within or outside the tolerance
specified in the probing job. This status is displayed graphically:

Deviation within tolerance

Deviation outside tolerance

Click the table header of the Deviations column to sort the values by size. If a command such as Deform
entities is active and the start and target points are selected there, you can left-click the table header of the
Nominal and Measured columns to select all probing point coordinates.

The same procedure is possible if only probing points outside the tolerance are to be transferred for a
probing job. For this purpose, only display the probing points outside the tolerance. In the probing job, on the
Contours tab, during Contour selection, click the table header of the Nominal column.

On the context menu

• Open probing job: Open probing job. The command only appears if the job linked to the probing data exists
in the CAM browser of the open document.
Double-clicking with the left mouse button on the probing point to be examined also opens the probing job.
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• Zoom: Zoom the graphic section so that the selected probing points are displayed centered in the graphics
area.

• Activate only this: Display the selected probing point in the graphics area, but do not display all others.
• Activate all except this: Do not display the selected probing point in the graphics area.
• Import probing data: Select a file with probing results. Existing, previously read-in probing results are

retained.

Trend
For each probing point, analyze the trend for the change in the accuracy of the machining from several
measuring logs of a probing job. To do this, read in several measuring logs. Select a probing job in the
probing job tree structure.

The information is arranged in a table-like tree structure. The Name column contains the number of the
probing point. The Run column contains the time at which the respective measuring log was created. The
measured values are displayed in the Measured column. The calculated value of the deviation is displayed in
the Deviation column. The deviation is checked to see whether it is within or outside the tolerance specified in
the probing job. This status is displayed graphically:

Deviation within tolerance

Deviation outside tolerance

Click the table header of the Deviations column to sort the values by size.

In the Trend column, the deviation is visualized by setting it in relation to the lower and upper deviation. The
movement of the point and its color in comparison to the measurements provide visual information on the
development of the accuracy of the production of the workpiece(s).

On the context menu

• Open probing job: Open probing job. The command only appears if the job linked to the probing data exists
in the CAM browser of the open document.
Double-clicking with the left mouse button on the probing point to be examined also opens the probing job.

• Zoom: Zoom the graphic section so that the selected probing points are displayed centered in the graphics
area.

• Expand all: Fully expand the tree structure.
• Import probing data: Select a file with probing results. Existing, previously read-in probing results are

retained.
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Import probing data

Read in the first or a probing result. Add probing result of another probing process
(another workpiece).

CAM → Import probing data

Probing tab → Context menu → Import probing data 2024

Select a *.txt, *.log, or *.ompr file with measurement results. Existing, previously read-in measure-
ment results are retained.

Probing options

Options for reading and displaying probing results.

File → Options → Probing options 2024

The settings are stored in the applicationProbingProperties.xml file are not document-related.

Options
Layout mode: Select which method to use to avoid overlapping labels. If Default is selected, the labels are
displayed evenly aligned. If Opposite is chosen, they are displayed alternately in the other direction. If Level
of detail is selected, the label with the greater deviation from the target value is always displayed when two
labels overlap.

Color - nominal: Enter a color for the target state.

Color - within the tolerance: Select a color for probing results within the tolerance.

Color - out of tolerance: Select a color for probing results outside the tolerance.

Point size: Select a size for the point that indicates the position of the target state and the probing result.

Leader line tail length: Select the length of the leader line between the point of the probing result and the text
of the label.
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Font: Select a font for the text of the label.

Text size: Select a size for the text of the label.
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3. Release notes

Release 2024
CAM
New default values for filleting toolpaths

• The default value for toolpath filleting (Fillet radius) now always refers to the Diameter of the tool used. In
addition the Fillet all toolpaths function is enabled by default. This applies to subsequent cycles:

2D Milling

• Pocket Milling
• Contour Milling
• Contour Milling on 3D Model
• T-Slot Milling on 3D Model
• Chamfer Milling on 3D Model
• Inclined Pocketing

3D Milling

• Profile Finishing
• Z Level Shape Finishing
• Plane Machining
• Arbitrary Stock Roughing
• Z Level Finishing

3D Advanced Milling

• Complete Finishing
• Automatic Rest Machining
• Corner Rest Machining
• Cutting Edge Machining
• Rib / Groove Machining
• Form Pocket

5X Cavity Milling

• Profile Finishing
• Z Level Finishing
• Rest Machining
• Corner Rest Machining
• Z Level Roughing
• Radial Machining

5X Surface Milling

• Top Milling
• Iso Top Milling
• Shape Offset Finishing
• Tangent Plane Machining

2D and 3D machining - Improved performance for NC generation

• The time for NC generation for 2D and 3D machining without activated optimizer has been improved.

3D Plane Machining - New pocketing algorithm

• The new algorithm ensures faster machining times on the machine and a more smooth toolpath layout
especially with a big stepover (ae).

• (1) Old algorithm, (2) new algorithm

hyperMILL®

89



1 2

• The logic of how toolpath fillets are applied in the toolpath layout has been enhanced. The fillet radius
specified in the user interface is now only used for fillets on the model contour (1). All other toolpaths are
filleted automatically (2).

1
2 2

1

• The new filleting method ensures that the fillet for the toolpaths on the model can be set individually without
affecting the fillets on the remaining toolpaths.

• This ensures a more smooth machining on the machine and avoids rest material if fillets in the remaining
toolpaths are desired.

3D Automatic Rest Machining and 5X Cavity Milling - Rest Machining

• Several important improvements have been introduced for theses cycles:
• A completely new rest material detection algorithm has been introduced and replaces the old. This new

detection results in a more reliable rest material recognition and faster computation times.
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1 2

• A new toolpath pattern removes rest material in certain situations such as corners or the intersection of
multiple toolpaths.

• The logic for splitting and connecting toolpaths has been improved. The result is shorter processing times
on the machine and a better surface finish.

3D Cutting Edge Machining

• Collision avoidance in Reference job mode: Collision avoidance can be activated while rest machining
(Reference job mode). The cycle will detect possible collisions automatically and adjust the machining
depth within the toolpath calculation to avoid collisions.

• Infeed mode ZigZag for plunge milling: The Zigzag can now also be combined with the Plunge machining
mode. This is typically used when finishing contours with plunge milling.

• Cutter compensation for plunge milling: Cutter compensation with Compensated center path can now also
be used for plunge milling (Plunge Machining mode).

5X Cavity Milling - Rest Machining

• A new algorithm to find a fixed tool inclination for steep and flat rest material areas.  This algorithm replaces
the old one and is used when machining with the 5X Mode Automatic indexing. Additionally the new
algorithm will now try to machine flat areas preferably with a vertical inclination (A/B = 0°, C = 0°) if no
inclination is necessary.
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Cycle definition - User interface
The dialogs for job definition are now designed in such a way that all tabs are visible without having to show
them using the arrow keys  on the right-hand side of the dialog when using the Icons option for the dialog
tabs (see CAM → Setup → Settings → Application)

Tool database

CHANGED USER GUIDANCE
Since version 2024, the coupling types Weldon, Weldon shank and Shrink fit became
standard types and can be directly used in the coupling area of the component (Tool,
Extension, Holder, Tool holder). For tools the Diameter of the top coupling is automatically
adapted to the tool diameter or shank when present. Tools using former coupling classes
are automatically converted.  

New coupling types

• With version 2024, two new standard coupling types, Shrink-fit - Safe-Lock and Schaft - Safe Lock are
available in the coupling definition.

Tool breakage check

• The tool database has been enhanced with the Tool breakage check option. If the Virtual Machine is
prepared for this, a breakage check is carried out before the tool is placed if this option is active. Please
ask your OPEN MIND contact person if you need this option and your Virtual Machine is not prepared for it.

Tool series and technology templates

• Due to the larger scope of technology parameters of the types of cut, the interfaces to external tool
management systems cannot currently be used. In this case, please keep using the default usages for the
time being.

VIRTUAL Machining Center / SIMULATION Center

Visualization for turning operations

• The VIRTUAL Machining Center and the SIMULATION Center are now visualizing the part, stock and
fixture as rotational geometry in case of turning operations. Also the collision check is using the rotational
geometry. For the part and fixture it is therefore  now required to define a 2D Contour which is used for the
rotational visualization and the collision check.

With this technique it is possible to add undercuts or ISO fit changes to the 2D contour
without collision detection for the turning operation.

Reduction of the collision check time

• The calculation time required for the collision check with a stock model when using tools with free defined
geometries or indexable cutters has been significantly reduced.

VIRTUAL Machining Center / Toolpath preview

• A toolpath preview is also possible if the VIRTUAL Machining Center has already been started for the
relevant job list (see context menu Generate NC file / Generate NC file (batch mode).
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• The VIRTUAL Machining Center can also be used to generate an NC file if a toolpath preview is already
running.

• This applies separately for each job list in the hyperMILL® job browser.

VIRTUAL Machining Center / Heidenhain controls

• It is now possible to check the correct tool radius and corner radius within the NC program in addition to the
tool length.

• OPEN MIND has noticed an unexpected behavior of the control on machines with head/head kinematics
without an endless rotating C axis in combination with a HEIDENHAIN TNC640 control.  The control does
not necessarily take the current position of the two rotary axes into account when executing the PLANE
command. The 'OM_ROT_AXIS_POS_TEST' is terminated with an error (FN 14: ERROR = 1005 ; Start
position not allowed). This enhancement to the VIRTUAL Machining Center contains the following points:

• PLANE parameter SYM (instead of SEQ)
• the call of the subroutine WA2_CORRECT_V2.H created by HEIDENHAIN

hyperMILL® VIRTUAL Machining

Changed user guidance

• For better support of turret lathes and milling machines with rotary axes, the C-axis control in the job has
been adapted. It is now managed via a drop-down menu. Existing settings are automatically converted
according to the following logic.

• Previously: Use preferred C angle is not active → New: Preferred solution C-Axis (A/B = 0) + drop-down
menu Frame

• Previously: Use preferred C angle is active +  input field → New: Preferred solution C-axis (A/B=) +
drop-down menu Angle + input field

• Depending on the selected machine, the additional options  Axis change and Transform polar are available.

3D Milling with rotational axis

• For 3D milling it is now possible to transform a XY milling movement into a rotary axis and linear axis (e.g.
CX) milling movement. To activate the function, activate the Axis exchange option on the NC dialog page
under VM → Preferred solution C axis (A/B0=0).

• Die Position des Werkzeugs durch Ändern des Wertes für den Winkel steuern. Die Grundposition 0°
bezieht sich auf die X+ Achse des NCS. Der Wert für den Winkel ist ein Raumwinkel (gegen den Uhrzei-
gersinn). Falls der vorgegebene Wert für die Fräsposition zu einem Problem führt, zum Beispiel eine
Achsbegrenzung, so wird automatisch eine Optimierung durch den NC Optimizer ausgeführt.

• Voraussetzung: Die Funktion NC-Optimizer verwenden ist aktiviert im Maschineneigenschaften-Dialog.

VIRTUAL Machining Optimizer

• The blending length defined for the rewind movement (Rewind) can be automatically reduced by the  VIR-
TUAL Machining Optimizer. The automatic reduction of the blending length is activated in the VM configu-
ration under Rewind. The blending length is only reduced if a rewind is not possible without a reduction,
e.g. in case of strongly limited rotary axes.
Attention: The blending length can be reduced to the value 0.

CAD
Additions and notes

System check tool

• Help → Automatic profile setting: The global setting “Workstation App-Dynamic Streaming” for an NVIDIA
graphics card is optionally set up automatically if the settings no longer correspond to the recommended
setting – for example, if the base profile is set after a Windows operating system update.
In addition, the environment variable HC_NVIDIA_GLOBAL_PROFILE can be used to specify an alternative
setting (for example, “3D App - Visual Simulation”) that is set instead of this default setting. If this environ-
ment variable is an empty character string, the setting is not defined.
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If the NVIDIA Control Panel is open while the check is running, the NVIDIA Control Panel must be closed
and then opened again to see the change to the profile.

User interface

• The buttons on the SpaceMouse® from the manufacturer 3Dconnexion can be assigned CAD commands.
The SpaceMouse® based on the SDK4 protocol has been expanded to include the Rotation center > Use
Selected Item option, which focuses navigation on selected entities. If this option is enabled and entities
are selected, the rotation center of the SpaceMouse® becomes the center of the bounding box of the
selected entities. The SpaceMouse® buttons Fit and Orientation use this bounding box.

If the 3DxWare driver version 10-8-16 or an older version is installed, remove the hy-
perCAD.xml from the following directories:

• C:\Programmdateien\3Dconnexion\3DxWare\3DxWinCore\Cfg\

• C:\Programmdateien\3Dconnexion\3DxWare\3DxWinCore\Cfg\

• C:\Users\[USER NAME]\AppData\Roaming\3Dconnexion\3DxWare\Cfg\

• As part of the rebranding, some commands have been reorganized and renamed, for example, the help
calls for CAD and CAM, and e-learning have been combined under Help, and the “hyperMILL” menu has
been renamed CAM.

• On the Visibility tab: In Layer, a newly created layer is automatically set to current. In Layer and Color, the
commands on the context menu are divided into groups by hyphens.

• On the context menu and on the Model tab, the selected entities can be assigned to the current layer using
the Assign entities to current layer command.

Options / properties in file

• Graphic → System → Advanced: The “Advanced shadow map” and “Clipping plane to all entities” options
have been removed as they are no longer necessary.

• CAD Viewer: It is possible to change the unit of measure.

Interfaces

• Import PMI with MBD: MBD from STEP AP242, SOLIDWORKS, Siemens NX, CATIA V5, and PTC Creo
are imported for dimensions, surface finishes, and tolerances, and faces are assigned as tags. An explana-
tion [65] of this has been added to the software documentation.

• *omx and *.bnd: Data in the Inch unit of measure can be read in.
• Autodesk® Inventor®: There are improvements in supporting attribute categorization.
• PTC Creo: "Multibody parts" are now also supported.

For models from PTC Creo 7.0: The support of "Multibody parts" changes the naming of the layers when
importing models. Previously, the name of the file was used. With the current version, the name of the
"part" is used instead.
The file name is still used for older files.

Edit

• Copy: Properties for copying via the clipboard can be preset in the copy_defaults.xml file. For explanations,
see Copy [66].

• Commands for parametric modeling are combined on the Parametric submenu. The Spreadsheet com-
mand is also located there.

• Commands for the color libraries are combined on the Color library submenu.
• Align dimension: Align dimensions with each other. An explanation [67] of this has been added to the

software documentation.
• Stretch 2D: Stretch two-dimensional contour curves. An explanation [67] of this has been added to the

software documentation.

Modify

• Invert curves: The orientation arrows can now be (optionally) used to select the curves to which they refer.

Select
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• The “Project snap points” command has been renamed Snap point projection on workplane on / off.
• The “Pick through transparent color” command has been renamed Pick through transparent color on / off.
• Snap: The Curve intersection point mode also finds the intersection point on (imaginary) extensions of

adjacent straight lines for chamfers and fillets. For this purpose, move the mouse pointer closer to the
chamfer or fillet. Useful, for example, when dimensioning an edge that is chamfered.

1.
57

Shapes

• Sweep (two contours): Generate faces between two contours, optionally with top and bottom faces. An
explanation [72] of this has been added to the software documentation.

• From grid: Create a face from several curve chains in one direction plus several curve chains in the other
direction. An explanation [73] of this has been added to the software documentation.

• Chamfer: The “45” option has been renamed Symmetric.
• Fillet. To create a fillet with a Face - Curve, a handle has been added to determine the radius interactively.

Features

• Features can also be inserted on individual faces (in other words, not only in solids). The faces are
converted into open solids.

• Holes: Several thread and fit tables *.xml saved in the standard paths defined for the general workspace
are offered together for selection in one view.

• Protrusion (two contours): Create a protrusion between two contours that define the shape of the protru-
sion. An explanation [75] of this has been added to the software documentation.

• Slot (two contours): Create a slot between two contours that define the shape of the slot. An explana-
tion [76] of this has been added to the software documentation.

Direct modeling

• Direct modeling of side faces: A preview of the side faces is displayed if the Side faces option is enabled
for direct modeling.

V-sketches and parametric design

• As already mentioned under Edit, some commands for parametric modeling are combined on the Paramet-
ric submenu. The Spreadsheet command is also located there.

• Strict chirality: Select the chirality behavior. An explanation [64] of this has been added to the software
documentation.

• Automatic rebuild on / off: A recalculation is not triggered every time the V-sketch on which a parametric
design is based is changed, but optionally only after several combined changes. This saves time. An
explanation [75] of this has been added to the software documentation.

Work preparation for turning

Commands for preparing a turning contour have been added to the Drafting menu:
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• Trim 2D corners: Trim 2D corners. An explanation [72] of this has been added to the software documenta-
tion.

• 2D undercut: Insert predefined 2D undercuts based on a library (of model files). An explanation [71] of this
has been added to the software documentation.

• Reset 2D corners: Reset undercuts, fillets, and chamfers on sharp-edged corners. An explanation [71] of
this has been added to the software documentation.

• Round / chamfer 2D corners: Use criteria to find all required corners of a contour and round or chamfer
them. An explanation [69] of this has been added to the software documentation.

Work preparation

• Close any openings by covering – for this purpose, the Create capping option has been added to Repair
open solid. The functionality of the Close holes command has been extended accordingly.

View

• The “Toggle projection” command has been renamed Perspective view on / off.
• Under Stepwise view change, rotating the view in both directions with Counterclockwise rotation and

Clockwise rotation has been added.
• Hide / unhide → ...: The commands for showing and hiding points, faces, solids, meshes, curves, and all

entities have been revised. The new commands are around three to four times faster. V-sketches and
the sub-entities of groups are also shown and hidden. The user interface does not change and keyboard
shortcuts remain the same.

Analysis

• Two entities info: The dialog has been expanded to include searching.
The angle between a planar face (regarded as endless) and a cylinder (cylinder axis) is determined.

• Local curvature: In Configuration, it is possible to specify that a point on an entity, the direction of the
normal, and the UV directions are generated individually as required.

Electrodes

• Imported CAD geometry data often does not have the quality required to create an electrode. Despite
undercut and missing faces, gaps between faces, and overlapping faces, the software allows electrodes to
be created on the basis of such CAD geometry data. A warning is only issued if the electrode geometry
does not specify a closed shape. It is up to the user to assess whether such a situation will have a negative
impact on the generation, NC programming, and production of the electrode, and whether it needs to be
corrected in advance.

• Automatically close features such as holes and breakthroughs inside a domain optionally. An explana-
tion [77] of this has been added to the software documentation.

Switch off the option for eroding lettering, for example.
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• Information on controlling the generator performance can be managed. For this purpose, the XML file for
generator program electrode option has been added. Default settings can be specified in this XML file. The
values are offered for selection in Create, Create user defined, and Modify EDM parameters, and are taken
into account in the completely revised EDM Converter. Also see the explanations in Preparing generator
programs [80].

• Create user defined: Simplified has been added to the Mode bounding box method. An explanation [78] of
this has been added to the software documentation.

• Detected collisions between an electrode and the workpiece are also displayed in the graphics area. The
first face of the detected collision is always marked. The following collisions are displayed:
• Electrode between start position and clearance position.
• Electrode in the start position.
• Faces
• Internal joint face in target position.
• Joint faces between start position and clearance position
• Joint faces between target and start position.
• Linear extension faces at the target position
• Rotated faces with model
• Stabilization extension faces at the target position
• Tangent extension faces at the target position
• Upper solids between target position and start position.
• Mutually colliding rotated faces

• User-defined tags can be used for electrode documentation. An explanation [79] of this has been added to
the software documentation.

• Modify eroding path: 3D curves including splines can also be selected for eroding paths. The eroding path
is broken down into individual waypoints.

• The position of the holder can be moved freely and is no longer limited to the scope defined by the block
size in X and Y and the size of the raw material in Z.

CAD for CAM

• The rest material display has been completely revised. An explanation [14] of this has been added to the
software documentation.

• A command has been added that can be used to analyze a face in order to find an optimal barrel cutter for
producing the face. An explanation [35] of this has been added to the software documentation.

Current restriction! In this first implementation, the tool is always considered normal
to the curve at the face tangent point. We plan to include a lead angle (positive and
negative) in the calculation in future extensions.

Bug fixes
The following issues have been resolved:

Updating recommended

• Feature → Hole: Crossed threaded holes in inches with incorrect thread texture when intersecting with other
holes. The matter has been resolved.

• Boolean → Difference: If solid A is locked and the Keep original solids option is selected for solid B, but
solid B is not locked, the Boolean operation will not work. The matter has been resolved.
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Release 2024 | Update 1
CAM
Bug fixes

Updating highly recommended

VIRTUAL Machining Optimizer

• Virtual Machine Configuration → Movements → Optimization → Rewind → Allow split G1 movements.
Fixed a problem where the toolpath was not split despite the option being activated.

• Virtual Machine Configuration → Movements → Optimization → Rewind → Allow split G1 movements → Allow
blending length reduction.
Previously, the blending length was unexpectedly reduced by the optimizer in special constellations despite
the option not being active.
With the new version, the reduction of the blending length is no longer carried out without activation.
In rare cases, this can result in no rewind movement taking place. If a reduction is required, it can be
activated, and the blending length can then be adjusted to 0 by the optimizer if this is necessary for a
rewind movement.

hyperMILL® VIRTUAL Machining

• If the option Stock contact → Settings for collision check → Allow thin shank contact was activated, an
incorrect collision message was issued during the collision check for a turning operation. This error has
been corrected.

• If a machining operation was loaded from Generate NC file (keep mode) from hyperMILL® not the updated
toolpath was simulated, but the previously simulated toolpath was simulated again. This error has been
corrected.

hyperMILL® VIRTUAL Machining / SIMULATION Center

• In the Turning → Axial Grooving cycle a change of the reference point was not correctly taken into account,
so that the tool was positioned incorrectly. This error has been corrected.

SIMULATION Center
A problem was solved in which - depending on the tool geometry - no material removal simulation was
performed in the SIMULATION Center.

3D Optimized Roughing

• An error has been corrected that caused a collision with the fixture, although the fixture surfaces were
selected as Avoid surfaces (Boundary → Avoid areas).

5X Shape Offset Roughing

• A problem with an aborted toolpath calculation has been fixed.

Tool database

• An error has been corrected that prevented *.hmc file from being opened.

Updating recommended

General

• When machining with a stock, in transparent mode not all holes were displayed when the job dialog was
open. This error has been corrected.

2D Contour Milling

• Fixed an issue that caused the update of an NC comment to be ignored when creating the NC file.
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3D Profile Finishing

• Fixed a problem with a very long calculation time when the Strategy → Machining mode → Slope mode op-
tion was activated.

• If the 3D path compensation function was activated (Setup → Tolerance parameters → 3D path compensa-
tion, a vector was not correctly taken into account on a Röders machine and processing was aborted. This
error has been corrected.

• Fixed a problem when using the options Boundary → Trim to Stock and Strategy → Infeed strategy → Zig
zag direct / Zig zag smooth.

hyperMILL® VIRTUAL Machining - Makino Probing

• The Workpiece alignment along edge cycle has been extended, so that the rotary axis can also be aligned
with tilted workplane now.

• A bug when setting the origin with activated tolerance check was fixed.

hyperMILL® VIRTUAL Machining / SIMULATION Center

• No removal simulation was performed during a turning operation with activated counter spindle. The error
has been corrected.

New commands

3D Optimized Roughing

• The Finish pass machining mode (known as Finish pass all levels from the 3D Arbitrary Stock Roughing
cycle) is now also available for Optimized Roughing.

• If this option is enabled, it ensures the tool moves along the entire defined contour, even if no material is
cleared. If there is still some rest material, this is cleared first and then the finish path is performed. You
should always enable this option, if minor changes were made to the allowance between two machining
passes.

3D Z Level Shape Finishing

• The functions for optimizing the machining tolerances for different machining situations already known
from the 3D Profile Finishing have been implemented also for the 3D Z Level Shape Finishing cycle. The
following functions are available on the Setup dialog page in connection with the use of the CAM Plan
functions (also introduced with version 2024):

Tolerance parameter
Tolerance use cases: Use the parameters of the tolerance use cases to ensure the best possible tolerances
depending upon the individual machining situation. The best settings are automatically used based on the
tool diameter and the selected Use case (Semi finishing, Finishing, Fine finishing, Micro finishing).

For Mode specify whether the toolpath is calculated in Standard mode or in High-precision surface mode. The
available use cases represent the typical machining steps during a milling operation.

High precision surface mode: Use when maximum accuracy is required to calculate the toolpath. The calcula-
tion of the toolpath is not based on the faceted model geometry, but on the real surfaces of the model. Only
available for Ball mill.

True Shape point distribution: Activate to redistribute points and guarantee an even and machine control-
friendly distribution of points.

To guarantee the best possible point distribution, use the CAM Plan function. The machin-
ing cycle automatically takes into account the topology information that was created with
the HPM–Milling task in the CAM plan.

Filter points: Points that are located on straight toolpath sections, for example a planar surface, and are
therefore not required, are filtered out.
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Please note that no or fewer points are not always the best solution for all machine con-
trols. For more detailed information, please contact the respective machine manufacturer.

Feedrate adaption: Activate to automatically adjust the feedrate depending on the curvature of the part. The
feedrate is reduced for concave curvatures (1) and increased for convex curvatures (2). This means that the
real contact feedrate of the tool on the part surface remains constant.

3D path compensation: Available for the Ball mill tool type. Enables various NC controls to machine the
model with a smaller or larger tool than actually programmed in hyperMILL®. In addition to the X, Y and Z
coordinates, the direction vectors I, J and K to the surface contact point must also be known.

Protect edges: When using the CAM plan, edges on the part are treated so that they are not damaged during
machining. This is achieved by inserting additional points in areas where sharp edges were previously found
in the component using the HPM Milling task.

The 3D path compensation function is available only with a specially adjusted postproces-
sor. Without this adjustment, the NC program cannot correct this output and, as a result,
both the component and machine may be damaged if the milling geometry used differs
from the milling geometry used to calculate the toolpath. To adjust your postprocessor,
please contact your OPEN MIND partner.

Tolerance settings
In the tolerance settings, adjust the parameters of the True Shape point distribution and Feedrate adapta-
tion functions.

Activate True Shape point distribution to guarantee an even and correct point distribution in toolpaths. The
parameters Calculation tolerance, Max. chordal error, Max. G1 length,  Min. G0 distance, Reference G1
length, control the arrangement and distances between the points.

Use the Adjacent sync. ISO parameter to achieve asynchronous point distribution between individual toolpath
segments by entering a (factor) value less than 1.

Function is not activated (1), Function is activated (2)

The Min. feedrate (factor) and Max. feedrate (factor) define the upper and lower limit for the feed rate
adjustment. The factor refers to the standard feedrate defined for the toolpath. Use Number of steps to
control in how many intervals the increase or decrease of the feedrate adaption is performed.

Feature technology

• A generic hole that was created in the CAM system and is contained as a list entry in the lower area of the
feature browser can now be imported into the standard hole library of the CAD system using the context
menu function Add hole to library.

• Features → Holes → Advanced → Library → [User Library]
• Example:
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hyperMILL® VIRTUAL Machining

DEFINITION OF THE CLAMPING POSITION REQUIRED
The position of the part on the machine table is crucial for correct visualization and testing
in the simulation. The clamping position is also used for other calculations such as the Best
Fit function and milling with a rotary axis.

The position of the part on the machine table is defined by the clamping position as
follows:

Job list → Setup → NCS → Define frame → Clamping position

In one of the next updates, OPEN MIND plans to make the definition of the clamping
position for the Virtual Machine mandatory.

We recommend that you define the clamping position in your current projects already now.
If you have any questions on this topic, please contact your support team.

Drilling → Back Boring
In the Back Boring cycle, the C-axis angle set in the job and a C-axis angle changed by the optimizer are now
also supported.

VIRTUAL Machining Optimizer

• Virtual Machine Configuration → NC → Common → Movements → Feedrate for linking 
The defined feedrate for linking movements is now also used for the linking movements within a machining
operation during axis exchange (milling with rotary axis).

VIRTUAL Machining Center

When performing a simulation, in Project administration operating mode of the VIRTUAL
Machining Center the currently simulated job (2) is now also highlighted in green in
addition to the tool (1), so that it is clear at a glance which job in the list is being simulated.
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Origin check for Fanuc, Mazak, Brother and Haas controls

• For Fanuc, Mazak, Brother and Haas controls, it is now possible to check the correct definition of the origin
on the real machine at the beginning of the NC program.

• The value of the origin used in the virtual machine is compared with the value of the origin on the real
machine. If this value is outside the specified tolerance, the NC program is aborted.

• This functionality can be used to ensure that the part is positioned on the real machine in the same way as
it was tested within the virtual machine. The tolerance is activated and set in the configuration of the Virtual
Machine under NC → Common → Origin checks.

Special attention:

• In the case of multi origins, all origins used are checked at the start of the program.
• When an origin is written by probing functions, the origin is checked again.

CAD
Additions and notes

Electrodes → Create user defined:

A user-defined electrode created with the Simplified option allows the target position in the
Z-axis direction to be set lower than the highest point of the raw material.  This allows
electrode holders for side electrodes to be positioned freely.

Electrodes → Export to EDM: If no part number is stored in the electrode options, the file name is used. For
ZK Alphamoduli predefined entries for measuring machines are supported. For ONA the electrode material is
now also supported.

Bug fixes
The following issues have been resolved:

Updating is highly recommended
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• CAM → Reports → ...: The tool and job reports have been revised and are now generated more quickly.
• Curves → Offset: In certain situations, the command causes the software to crash. This issue has been

resolved.

Updating recommended

• CAM → Optimal barrel cutter: If in Base diameter range the minimum and maximum values are the same,
any calculation is performed. Similarly, any calculation is performed if in the Barrel radius range the same
values are given.  Both issues have been resolved. 

• Electrodes → Create user defined: Creating a user defined electrode with the option Simplified crashes if
only one face is selected. This issue has been resolved.

• CAD interfaces

For all CAD interfaces, which are based on technology up to 31 December 2019, the
Product and Manufacturing Information (PMI) option in File → Open → Settings shall
remain for import at the BETA development stage.

The interfaces have been updated for Autodesk® Inventor® to 2025 and for CATIA V6 (3DXML) to 2024.
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